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Send Us Your Comments

Oracle Financial Services Lending and Leasing User Documentation

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this
document. Your feedback is important, and helps us to best meet your needs as a user of our
products. For example:

e Are the implementation steps correct and complete?

e Did you understand the context of the procedures?

e Did you find any errors in the information?

e Does the structure of the information help you with your tasks?

e Do you need different information or graphics? If so, where, and in what format?
e Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your
name, the name of the company who has licensed our products, the title and part number of
the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest
version of the document and if any concerns are already addressed. To do this, access the
Oracle Documentation available at www.docs.oracle.com which contains the most current
Documentation Library plus all documents revised or released recently.

Send your comments using the electronic mail address: financialservices_ww@oracle.com
Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative
or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle
local office and inquire about our Oracle University offerings. A list of Oracle offices is
available on our Web site at www.oracle.com.
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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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1.4

1.41

When you invoke the application, the Sign In screen is displayed.
ORACLE: B O

Financial Services Lending and Leasing

sign In

Please enter userid and password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
e Left Pane

1-2 ORACLE



e Right Pane/Work Area

ORACLE"
Financial Services Lending and Leasing

ovn - EISEE O

DashBoard
4 Dashgoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WP

> Tools

> Setup

You can view the application version details and copyright information by clicking About link
at the right bottom corner of the screen.

About

Oradke Finandal Services Lending and Leasing 14.3.1.0.0
Buld OFSLL_14.3.1.0.0_B253.

Copyright © 1885,2017, Oracle andior fs afflstes. Al ights reserved.

Oracke and Java are registered trademarks of Oracke andlor s af filates. Otfer names may be trademarks of thei respective owners.

property laws. Except as expressly perited in your lcense agreement or alowied by law, you may not use, copy, reproduce, ranslate, broadcast, modify, liense,
transmit, distribute, exhibd, perform, publish or display any part in any form, o by any means. Reverse engineering, disassembly, or decomplation of tis software,
unless required by law for nteroperabilty,is prohibted.

The information is subject

If you find any errors, please report them o us in wriing.

that US. Government or behalf of the U S. Govemment, the following notice i
appicable:

U.S. GOVERNMENT END USERS: g tem, any hardware, andior
documentation, delivered o U.S. - Jation and agency-
‘specific supplemental reguiations. As Such, use, duplication, disclosure, modificaton, and adaptation of the: programs, inciuding any operating system, inegrated
software, any programs installed on the hardware, andior documentation, shal be Subject o icense terms and icense restrictons applicable to the programs. o
other rights are granted to the U.S. Government

This software or hardware is developed for general use n 3 variety r use in any nherently
dangerous applications, including create 5 risk o pe jury. f you use this soft hardware in dangerous applications, then you shal
be responsibe to take all appropriate falsafe, backup, redundancy, use.

liabitty for any damages caused by use of this Software or hardware in dangerous applicafions.

may informaton on content, products and services from third parties. Oracle Corporation and ts
y respect o third-party content, products, and services. Oracle Corporation and
s affilates wil not be responsile for any loss, costs, or damages incurred due {0 your access to or use of tird-party conten, products, or Services.

| Qo |

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

AIDYA ~

* Welcome, & Sign Out[QA]
Change Password

m  UserInfo i3]

— Change Password — Click to change the current password.
L 7 I— TR

-
ek

Ir

s
e
-
-
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Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone |JSER TIME ZONE ¥
Division U301 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDVA Company US/CENTRAL (CENTRAL STANDARD
) i Branch Time TIME)
Responsibility SUPERUSER S
GLPost Date 02/10/2016 Server Time  ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT v Skin Family Skyros (Default) v

Debug Enabled Ind

|_—|5 Submit | 3% Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.
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You can click on 3= List Files button to view the list of logged files.

ORACLE’
Financial Services Lending and Leasing

FRAKRRAD o

DashBoard 3 System Monitor [3] Close

BatchJobs  Jobs  Services Database Server Log Files = Parked Transactions | Users -

Database Server Log Files

View v Format~ Freeze i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 fob 5706 02/18/2016 06:14: 11 AD »
ALERT lob 395 02/22{2016 03:59: 16 AN
CSYPRC_EN_100_01_DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP =
CSVPRC_EN_100_01 _DB12C_3854338 lob 116750 02/22/2016 05:36:42 A
JSYPRC_EN_000_01_DB12C_2094362 lob 5706 02/18/2016 10:57:09 AP -

v
File Content
View * Format v Freeze  CfiDetach ol Wrap B ©Begring@End #oflines 50 [E] Show File

Text

: 45:FLL:1v_use BI::¥
cmnsyp_cl_000_D1.get_syp parameter value value:
get_syp_parameter_value wvalu http://ofss2221142.in.oracle.com:..

get_syp parameter value value: http://ofss2221142.in.oracle.com:

weblogic

cunsyp_cl_|
crnsyp cl

emnsyp_cl_

_0l.get_syp parameter value value: /scratch/work area/DEV/QA143REL/r
cunsyp cl 000 01.

_0l.get syp parameter value paramerer
cunsyp_cl_000_01.
: cmnsyp_cl_000_01.get_syp parameter value parameter:

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug

details.

Time Zone Level - Select the time zone preference as User/Company Branch/

Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of

this user manual.

Click Submit to save the changes or Close to close the screen without changes.

Refer accessibility document for further details.

1-5

Accessibility — Click the link to view accessibility features of the system.

NextGenUI - This is Next Generation User Interface option which is an enhanced
interface provided in OFSLL using the Oracle JavaScript Extension Toolkit (Oracle JET)
frame work. This is an additional interface supported from OFSLL to the existing system
and both intended to coexist in the system till further updates.

This option is enabled only if the corresponding system parameter is enabled in the
base system as configured by your system administrator. For more information, refer to
‘Appendix - Oracle JET Interface’ section in Servicing guide.

Sign Out — Click the link to sign off from the application. You can also click on ==
icon to sign off from the application.
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Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click > to expand the Module Master Tabs and « to collapse them.

> DashBoard

> Origination

Servicing

Eles :

Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions
Account Documents i
Collateral Management

m

Reports
Producers
vendors
Batch Transactions
Interfaces
AP Transactions
GL Transactions ~
> Collections
> WFP
> Tools

> Setup

To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is
displayed in the main window/work area.

ORACLE’ ) SSHEKAR ~ 1 sgnout ©
Financial Services Lending and Leasing

4 @8 | Access x (3 Close:

Appication Retrieval(Origination) Data Sween Reports | Corespondence | Transaction
Applcation Documents (Crigination)
hsset Types(setup Products) Aeoes Gild o add || ZEit | Elven || 2 auit
Account Documents(Servicing) o e Freeze i Detach —_—"

Organization Division Company Branch Alowed

. r ) DMC usoL AL ALL
‘Application Entry(Origination) oG NLO2 AL ALL

Audit Tables{setup System) e sA03 AL AL
Advances(Servicing Batch Transactions) e P04 AL AL

Access(Setup User) |
AP Transactions{Servicing Interfaces)

¥
¥
Y
Y

> Origination
> Servicing
> Collections
> WEP

» Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through
the module from which the screen is accessed which is indicated in angular brackets. For
example typing 'VEN' displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.
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Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

ORACLE
Financial Services Lending and Leasing

# Welcome, vAVAIYA - DSEREREE —

Sales Lead x [EEE

124081987

> sarviang
> Collections
> wrp
> 1ools

> setup

You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

RACLE
Financial Services Lending and Leasing
T

ocessing Details
=3 Freeze i Detach Wrap L]

> Collections
- wee
> 100ls
> setup

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

You can also open multiple Accounts at the same time as separate tabs in the right window,
provided your system administrator has enabled the option 'Mac_Multi_tab_Ind'="Y’ in
MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 Accounts in parallel
tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the
opened tabs.

However, this option is restricted only to the following screens in Servicing Module Master
Tab. In the Left Menu of Servicing Module Master Tab, you can open multiple accounts by
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clicking on the Customer Service link. Each successive click, opens a new Customer Service
tab.

ORACLE HEGR 1 signout O
Financial Services Lending and Leasing
@8 Customer Service 3 | Customer Service % || Customer Senvice || Customer Service ¢ | Customer Service (@ Close
Search  Customer Service: 20160700010076  Review Request (Pending: 0)  Queue Assignment Z
> DashBoard
 Origination Account(s): 20160700010076: MILLEN JOHN Even | o adt
View ~ Format v Freeze Detach Wrap £ © Current(® Show All ©) Group Follow-up
Serviding & o P ® &
Company Branch Sub Unit Account ¥ Product Days Past Due Currency Pay Off Amt Amount Due St
Servicing NLO2 NLHQ UNDEFINED 20160700010076 LOAN VEHICLE (FR) -23 ELR. 50,089.31 0.00 m
Customer Service Al = = = ———— = = =
Securitization

Transaction Authorization
i e Summary | Customer Service | AccountDetals | Customer Detsils  Transaction History | PmtModes  Bankruptcy | RepojForedosure | Defidency  Colateral | Bursau | CrossfUp Sell Activi > ~
ost Date Ches

Escrow Transactions

Account Documents Alerts Conditions
Collateral Management
Reports Alerts Conditions
Producers Alert Condition StartDt Followup Dt
Vendors PRIM CUSTOMER ( JOHN MILLEN ) MARKED AS DECEASED, UPDATED PERMISSION TO CALL FLAG AVAILABLE FOR REPOSESSION 08/09/2016 08/30/2016
Batch Transactions 4 AS N FOR ALL CONTACTS DEFICIENCY 08/09/2016 08/30/2016 |
Advasices LIEN PERFECTED 08/09/2016 08/30/2016 =
Payments
Fees
Interfaces
Account Details Other Information
2P Transactions
GL Transactions .
Dues Collateral Information
Conversion Accounts |
Descrption Identification Year  AssetClass  AssetType
0.00 0.00 0.00 0.00 0.00 0 TOYOTA CAMRY a useD VEHICLE
R il 0 PR i G
Delg Due 0,00 Todays Payoff 50,089.31  AmtPaid Excess 0.00 ’ .
> Collections LCOwe 0.00 Future Payoff 50,158.61 Mermo Excess 0.00 Qitous lnformato
< 2 ik Customer
s NSFDUe 20,00 Future Payoff 08/15/2016 . Name Relation SN National
2 Date Paid Tern 0 -
ouroe 9 000000... JOHN MILLEN PRIMARY socxxx-3456 -45478
> Tools TotalDue  20.00 Future PmtDt 08/28/2016  Remaining Term 6 = = 5
> setup OldestDue Dt 08/28/2016  Days to Time Bar q
e R | %

Few screens in Servicing and Collections are identical and are linked. Hence, when multi tab
option is not enabled, you can open only one screen at a time from the group. A sample of the
grouping structure is given below, based on stages of the screens:

Collection:

e Collection

e Bankruptcy

e Repossession
e Deficiency

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and |: to toggle the view of Right Splitter/Action Window.
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Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

ORACLE" % Welcome, VAVAIDYA o
Financial Services Lending and Leasing
Close.
e origiation x EE
Search/Tack | Funding: 0000000378 | Review Requests (Pending: 0)
Application: 0000000378: TIFFANY RUSSEL / GRACE ER
View~ Formatv B} | (]| Freeze g Detach wsp B OvemideOK v WamingOK ¥
pre
o nop sub it status Origination Stege g cer ame Co Bstng Customer  2UP1C contact
tu
oxjosf2012 0000000378 UNGEFINED APPROVED-FUNDED  FUNDED GA-000D4 : ADVANCELER... . N N
, Summary
Requested  Approved
Advance 1500000 15,000.00
Summary | Applicant | Request || Decision | Contract || Collateral | Comments || Tracking || Document || Verification | Correspondence || Toals o R FHoa00
Tem 3 S
> Applicant Grade  DGRADE S 0
v 00
Stated PTI9s4
4 D Ratios Book 10,000
» Bureau
Queve FUNDED APPLICATIONS QUELE
b Checklist Change Status
Status APPROVED - FUNDED
Collateral Change Status
Colbateral Add Comment
Asset Type SubType Primary  Vear Vake Vodel Hileage New Wholesale Value 3
~ Serviding VEHICLE AR B 2012 CHEVROLET MONTE CARLO on 10,000.00 Alert
> Collections *Type v
> “sub v
RaWED, Trade-Tn Type
> Tools * Comment
b Setup Trade-In o -

Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.

For detailed information on the above options, refer to respective sections in the
document.
Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:

RACLE
Financial Services Lending and Leasing

Dues
09302017

osj0/2017
003 50,

003

o7 ooy osjojmr
3 o 15%.

col

dlector DEMOCOLL

Colateral Information
Py Descpton Ldentication #
2006 CHEVROLET MONTECARLO R

Customer Information
CSON ame Relaten

000000... MADHAN ORAGLE PROUARY

Enai EDW.SRSIGGMAL COM

Tive

Malng  Address

HouE v v 745 newyork MA-34038

Employment Information

BAPASGURITES2 06 NEW

Customer service (3§ Cose
Searh
Account(s): 2017010001007 Elvew [ LAt
Vews Fomate | B | MFeen Elivent o | W B ©CurentSon MO GromFlowss
Conpany wanch bunt Dayspastoue usrency Payoffant  Amountoue Stais OdstoueDt  DxQReason
st sk ) 150155 250021 (T N /017 15 PaveNT . ——
Bsbnt | [ @aex
Somary | (| [ S| At [ s G Pk T oy Pt [y e Do [l o] (o [ e A v ey
Qe Conditin =]
Meris Conditons Atorun
B textAccount
Rlerts Conditions ik
At AccontConiton Contionsrtot
No data o dlay Repossession s o FEEEES
oenauEn oy o P m——
=
=
AecountDetais Other Information

ew  Bssetcass AsetTpe  SbType
BiaE  om

National D a0t Gender

o o372s/sses uosneD

vy OptOut ¥

Phone

yses337

Eeestoment | [ G oer

=
=
=
=

B Fostcal vty | [ @ Cear
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e Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking ‘Next Account’ button opens the subsequent account listed in search and
clicking ‘Filtered Account’ opens the subsequent account fetched during a queue search
and listed in Queue Assignment section.

e Use Add Comment section to post an alert or comment based on Type and Sub Type.

e Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click =i to toggle upper pane and j to toggle left
pane. To un-toggle click == and |: respectively.

1.4.1.1 Time Zone Preference

Oracle Financial Services Lending and Leasing ®
User Info

Organization DMC Time Zone |JSER TIME ZONE v
Division US0L Level
First Name VARSHA User Time Zone  UNDEFINED
o e A Company US/CENTRAL (CENTRAL STANDARD
) : Branch Time  TIME)
Responsibility SUPERUSER e
A T Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT b Skin Family Skyros (Default) »

Debug Enabled Ind

Dh? Submit || 3% Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.
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1.4.2

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e Inthe Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone' is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.

To modify the User Time Zone:

e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service @

‘SEE\(\! Customer Service: 20120200010231 Pme.uR!qhe:t‘\Penmug:D)‘

Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE [E]view | o audt

Vieww Format 5} Freeze i Detach ap | W) & @ curent O ShowAll © Group Follow-up
Company Branch Sub Unit Account # Product Days Fast Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
usi1 USk1 UNDEFINED 0120200010231 LEASE VEHICLE 0 UsD 0,00 0.00 ACTIVE 02/10/2015
[ summary | Jcustomer Service] | Account Detil || Customer Detalls| TransactionHistory | Pt Modes | Bankruptey | Repo/Foredosure | Deficiency  Colleteral Bureau _Crosslp Sell Acivies |
‘ Call Activities | Maintenance Comments Promises | Checklists Tracking Attributes | References | Correspondence | Letters  Document Tracking
call Activities dpadd | ZEit | [Fvien | o audt
Views Formatv [ Freeze A Detach wap @
Action Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Followup Dt Time Zone Adj Follovup Dt Cor
AT PH ANSWERING MACHINE N 12300015 1,000.00 NONE N 1f0j01s 12{29/2015 12:30:00 P

AT PH ANSWERING MACHINE N 12/302015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
b

You can click # to view the hidden tabs, if any.
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1.5 Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.

e Basic Operations

e Basic Actions

e Personalization Options

e De-supported Special characters
e Skip Zip Code Validation

e Export data to Excel

1.5.1 Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
o Edit
e View
e Audit

e add | S Edit | 5 view | o Audit

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation Description

Add Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with *’ symbol.

Edit Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit Click to view audit info. If an audit is set for a field, then the system

tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.
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1.5.2

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

Save and Add

[ save and stay

[ save and Return

<3 Return

The table below gives a snapshot of them:

Basic Actions

Description

Save And Add

Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay

Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return

Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return

Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.

The Payment maintenance screens consist of the following actions.

Post and Stay

E Post and Return

<:] Return

The table below gives a snapshot of them:

Basic Actions

Description

Post and Stay

Click to post the transaction and remain in the same section. This
button is displayed when you click 'Modify Payment/Modify
Payment Transaction' button.

Post and Return

Click to save and return to main section. This button is displayed
when you click ‘Modify Payment/Modify Payment Transaction’
buttons.

Return

Click to return to main section without modifications. This button is
displayed when you click ‘Modify Payment/Modify Payment
Transaction’ buttons.

The summary screens consist of the following navigations. The table below gives a snapshot

of them:

Basic Actions

Description

Click to navigate to the first record.

Click to navigate to the previous record.

< [F[E

Click to navigate to the next record.
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1.5.3

Basic Actions Description

| A| Click to navigate the last record.

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|43r Download File - Click to download the details of selected data.

Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|“FlieWY Format « % Freeze HEDetach o] hirap E’ﬂl

The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View'.
M Format » | [Ep Freeze i Detach

Columns 4 Show Al
| : + Product |
Detach + Description |
Sort v ¥ StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...
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Options Description

Format Click to resize columns or wrap a data in the table cells.
|
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column m I

Column DESCRIPTION

width | 100 [&] [pixels  [=]
| OK | Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View = Format *’ Freeze ﬁ Detach A Wrap a!}
i i i | B [
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.

Wrap Select the column in which the data needs to be wrapped and click
Wrap.

Product Definition . TN L= R T I |
view - [Faimats] | B | [Freee ffivetcn | [N | @ nes ¢
[poduct ot Jenaot
Wioan+e LOANHOME (R)  P1/01/1800 12/31/4000

LOAN SECURED
LoaNSG 12/31/4000

|Coliateral Type  |Collateral Sub Type: 15;;:@@:
HOME COLLATERAL® REAL PROPERTY HOM INSTALLMENT

HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT

WR)

LOAN-AUN B SRR 011500 12/31/4000
LOANAE EOANVERICLE(FR)! b1/01/1800 12/31/4000
D1 [ 3/08/1863

UNSECURED COLLATIUNSECURED INSTALLVENT

VEHICLE COLLATERA PERSONAL PROPERT INSTALLENT
VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT

MURABAHA = 1/01/1500

NDS1 NORM DSER. 3/11/1853 31/2000
NPOL neos 1/01/201 12/31/4000

HOME COLLATERAL  REAL PROPERTY HOR INSTALLMENT

UNSECURED COLLATIUNSECURED INSTALLVENT
HOME COLLATERAL REAL PROPERTY HORMORTGAGE

Click to refresh the data in the table.

View Last For usability and performance, some of the data intensive screens
have ‘View Last’ option to sort the volume of data being displayed
on screen based on elapsed days.

ViewLast ©) 1Day @) 1Week D) 1Month@ By Date  startDt 07/01/2017 b EndDt 092002017 b &8

You can select the ‘View Last’ option as 1 Day / 1 Week / 1 Month /
By Date. When ‘By Date’ is selected you can specify a date range
(within 3 months) in ‘Start Dt and ‘End Dt  fields using the adjoining
calendar and clicking ‘Search’.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the
contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new
tab is opened where the print content is displayed.
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Detach

ORACLE
Financial Services Lending and Leasing

. Welcome, vavaY: - ERSEISIGN O

Close
e L3 customerseve ¢ e
ORI Search | G quest (Pending: 0) 7
Servicing
Sencing Account(s): 20120200010231: YUTAKA OZAKA / AKANE [Elview || «2 Audt
Citacienserae Views Fomatv B [[Freze HiDetach Jwap @) & © Curent O ShowAll O Group Follow-up
Secuitzation Company Branch sub Unit Account = Days Past Due Currency Pay Off Ant Amount Due Status Oldest Due Dt
Transaction Authorization usog Usk1 UNDEFINED 0120200010231 LEASEVEHICLE 015D 000 0.00 ACTIVE 02j10/2015
Post Date Checks
S Trbedive Summary | Customer Service | Account Detals | Customer Details | Transaction History Pt fodes || Sankruptey | Repo/Foreclosure | Deficency | Collateral | Bureau | Cross/up Sel Activities
Account Documents
Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes References Corespondence  Letters Document Tracking
Reports
Producers i .
Vit Transaction Batch Information padi | et | Bvew | o auit
Batch Transactions View~ Format~v [ Freeze £ Detach Wrap W {5 post [ void
Adiances Date Monet Transaction status Batch
Pajments | 02/10/2016 'ADD CUSTOMER ADDRESS PHONE POSTED ]
Fees oot v TERMINATE ERROR ]
Interfaces 01/06/2016 ¥ TERMINATE Vo N «
P Transact 01050016 EXTENSION vom N
Detached Table x
Vieww Formatv [ Frecze [HDRRAR] o wp | @ 1 Vaid
Date Honetary Transaction Status Batch
zj10/2015 N ADD CUSTOMER ADDRESS PHONE POSTED N
01/07/2016 Y TERMINATE ERROR N
01/06/2016 Y TERMIATE o N
01/06/2016 Y EXTENSION vo N
12232015 Y PAYOFF QUOTE LEASE POSTED ]
Views Formatv [ Freeze G Detach wap @
> Caollections Transaction Frocessing Details
S WP Transaction Posting Successful =+
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:

e Drop-down list — Provides the selection option. You can either select a record from the
list or enter first alphabet of the required value.

e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

2 Welcome, VAVAIDYA o

ORACLE"
Financial Services Lending and Leasing

> DashBoard
» Origination
Servicing

Senvidng

Customer Service x.

Search | G ice: :0)

Account(s): 20151200010012: MADHU BOBBURI

Customer Service
Securitization

View~ Fomat +
Company

Transaction Authorization vsor

Post Date Checs

Escron Transactions

Account Documents

Collateral Management

Call Activities
Reports

Producers

Vendors Transaction

Batch Transactions.

Date
Fayments

02/10/2016
Fees ‘ 04/25/2016
Interfaces 01/2212016
AP Trans: 030712016
12/15/2015
Transaction
Parameters
P View v Fomat
\ Parameter
> WFP o data to display.
> Tools
> Setup

Result

Summary | Customer Service | Account Details

Maintenance | Comments  Promises

View v Format v

B ] Freeze i Detach wap | G & ' cument O Showall O Group Follovi-up
Branch sub Unit Account = Days Past Due Currency
uskg 2015120001012 LOAN VEHICLE (FR)

Customer Details || Transaction History | Pt Modes | | Bankruptey | Repofroredos ¢ o o

Checkists || Tracking Attributes || References || Correspondence || Letters [ Jsamrch

Matfh @ all O Any
Batch Information

53 Freeze Efipetach | Jwap @

Transaction

et Ghvod

¥ — = ACCOUNT NG
™ i ADIUSTMENT}

Batch Information

search
Date 02/10/2016
* Monetary @) et
tv & Freeze &t Detach Wrap 5]

(3] Close.
Elview || o audit
Pay OFf Amt Amount Due Status Oldest Due Dt
5031881 EECEN v oeLo:non perro. (TR
x
Advanced
b dd | 7 i || Elvew || Pasdt
[ search Transactlhe
|
Search Basic

Match ® All ) Any
Tn Code

| Description
n

| [ Reset | [ AddFields || Reorder

Desciption
o rous to dis

Greater than or equal to
Betueen

oK || cancel

Value Required

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu

Do this

Basic

Click ‘Basic’ for normal search.
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1.5.4

1.5.5

Buttons/Menu Do this

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select
the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual
ones.

| * Channel | WEB ENTRY = * Producer Name [
NY-02: PR HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR A 1
TIF-OUOO L T TEST-00T RTINS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

De-supported Special characters

OFSLL ‘does not’ support the following special characters while accepting data through Ul,
web service and file upload process.

<>{}N\*[1"
Hence, ensure that the same is not used while processing any input data in the system.

Skip Zip Code Validation

While accepting data for interdependent fields through User Interface, OFSLL validates and
auto-populates the values for subsequent fields based on previous selection.

Accordingly, when a specific ‘Country’ is selected from drop-down list which is populated

based on COUNTRY_CD (COUNTRY CODE) lookup code, OFSLL validates and populates
the list of corresponding zip codes maintained in Zip Code setup.
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However, in case the zip code validation is to be skipped for a specific Country, then define
the Sub Code as NO_ZIP_VAL against the COUNTRY_CD in lookups screen as indicated

below:
Lookups x 38 Close
Lookup Type W add || ZEdit || 5] View || & Audit
View v Format v {Ef Freeze ;j‘ Detach Wrap @
Yes
& %COUNTRY%%
No
A System Defined
Lookup Type Description Yes/No Enabled
COUNTRY_CD COUNTRY CODE (SORT BASED ON CODE) Yes () No Y
»
Lookup Code P Aadd || ZEdit || ] view || & Audit
View ~ Format ~ (i) Freeze B Detach Wrap 2}
é Yes
%NOY
YoNO% o
Lookup Code Description Sort Sub Code SysromibHined Enabled
Yes/No
UK UNITED KINGDOM 1{NO_zIP_VAL Yes (. No Y
SG SINGAPORE 1|NO_zZIP_VAL Yes (' No =

On Selecting that particular Country from drop-down in any of the Ul screen, only the default
value ‘0000000000’ is available for Zip field drop-down list. On selecting the same, the City
and State fields are set as UNDEFINED.

Producer Details

[ save and Stay, || [ Save and Return || @ Retum

Producer # CO-00004 Address Line 1 2145 HWY 50 WEST Max Float 99,999
Old Producer # C0-00004 RS TiRE Remaining Float 99999
* |
Name DALE SPRADLEY MITSUBISHI Country | UNITED KINGDOM v Enabled
Company  ARGO1 v =
Zip 0000000000 Subvention Participation
Branch | ARO1 v ) 0000000000 UNDEFINED UNDEFINED
Zip Extn
Start Dt 05/27/1994 &y et
City MO T
End Dt 12/31/4000 | @ )
State UNDEFINED v Collection Type ' STATEMENT i
JACK -
Contact * Permission to Collection Frequency MONTHLY ¥
Group  NOT DEFINED i/ . pemussiaf‘::: Refund Disbursement 'NONE v
Method
Grade v Text Re o T =
egion
Type DEALER i Phone 1 (719)-543-6710 J
Territory | ALL 2
Status | ACTIVE v EinilG i,
Sales Agent % * Permission to License Details
Underwriter | DEMO UNDERWRITER v £l
* Permission t
Funides v e Valid From 01/01/1800 B
Collector  DEMO COLLECTOR v Phone 2 Valid To  12/31/4000 &

Note

Skipping zip code validation has significant impact in the system since the change impacts
all the Ul screens - Setup screens, Origination, Servicing and Collection module screens,
Interface, Customer Credit Limit, Collateral Management, and so on. Hence it is recom-
mended to be done with careful consideration and OFSLL is not responsible for any im-
pact/mismatch resulting out of this change.

1.5.6 Export data to Excel

While working on any of the screens in User Interface, OFSLL provides a flexibility to Export
the data that is displayed on screen to an Excel file. This helps to download and view the data
offline especially with data intensive screens.
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1.6

Clicking ‘Export to Excel’ option provides option to save the data to .xIs file.

Summary = Collections Customer Service =~ Account Details = Customer Details =~ Customer Preferences = Transaction History =~ Pmt Modes = Bankruptcy =~ Repo/Foreclosure — Deficien > ¥

Call Activities Comments = Promises =~ Checklists = Tracking Attributes | Field Investigation = References = Correspondence = Letters = Document Tracking =~ Scen: > ¥

Transaction Batch Information padd | AEdt | [ view | & Audit
View v Format v [ Freeze Efi Detach Wrap [0 % post Void | | Export to Excel
Date Monetary Transaction Status Batch
10/29/2020 i PAID OFF POSTED N
10/23/2020 N ADD CUSTOMER ADDRESS PHONE POSTED N

Parameters
View v Formatv [ Freeze B Detach Wrap ®
Parameter Value Required
TXN DATE 02/11/2020 Y
WRITE OFF INDICATOR YES Y

However, ‘Export to Excel’ option is currently available only to following screens and is also
access controlled depending on configuration defined in setup.

Queues/Search Results - Origination, Servicing, and Collections
Account Information

Balances

Call Activities

Maintenance

Promises

Due Date History

Collateral

Tracking Attributes

Condition Details / Condition / Queue History

In additional, OFSLL displays the total count of records fetched from database. The count is
displayed in the right bottom corner of records table. However, note that this is not the total
count of all the records in the database but only the records which are fetched based on
specific selection. For example, if there are 50,000 records in database and Ul is fetching
1,000 records, then the count is displayed as 1,000.

Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1.

Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt + y’.

Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

Arrow Keys to hover within the drop-down list.
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1.6.1

1.7

1.8

1.8.1

Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Browser Operating Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click
monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click
monic

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom
level.

Shortcut Action

Ctrl++ To increase zoom level.

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.
Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.
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1.8.2

1.8.3

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define
special accessibility preference in the application:

e The application user interface contents are readily accessible for all types of users
without the need to select special accessibility modes.

e The components within the user interface are optimized for use with a screen reader by
default.

e The contents are zoomable by default, eliminating the need for an application large fonts
mode.

e The user interface components auto-detect if operating system (OS) is set to high
contrast mode and automatically render content that is compatible with OS high
contrast, eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built
on Oracle Application Development Framework (ADF) and the default accessibility feature
supported by ADF are made available. For additional information, refer to ADF documentation
on accessibility preferences.

Documentation Accessibility Preferences

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics

e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
e Usage of styles and formatting elements

e Documentation in simple language to ensure easy understanding

e Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate

1-21 ORACLE



2.1

2. Wholesale Floor Planning Setup

This chapter explains how to use the Wholesale Floor Planning Setup window to set up the
WFP module in Oracle Financial Services Lending and Leasing.

Note

Although WFP is a separate module, it uses the Oracle Financial Services Lending and
Leasing system’s seed data, as well as lookup codes defined on the Setup menu’s Admin-
istration form. The Wholesale Floor Planning Setup form only records setup data specific
to the WFP module (just as the Setup menu’s Product module records data specific to the
Loan, Line of Credit, and Lease modules.)

Please do not set up the Wholesale Floor Planning module until after you have completed all
other aspects of Oracle Financial Services Lending and Leasing setup.

Set up the WFP Lookups

Note

For more information about lookups, see this section of the Lookups link (Lookups Set-
up Screen) in the Administration System Setup of this guide.

To set up the WFP lookups

1.

On the Oracle Financial Services Lending and Leasing home screen, click the Setup
master tab.

Click the Administration bar link.

In the Administration screen’s link bar, click the System drop-down link, then click
Lookups.

In the Lookups Setup screen’s Lookup Types section, the following lookup codes apply
to the WFP module:
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211

Set up the WFP Parameters

Lookup Type:

Description:

WFP_ACCR_BASE_DAYS_CD

BASE DAYS FOR COMPUTING ACCRUALS IN
WEP

WFP_ADJUSTMENT REASONS CD

BATCH FILE ADJUSTMENT REASONS

WFP_ADJUSTMENT TYPES CD

BATCH UNITS FILE ADJUSTMENT TYPES

WFP_BATCH_STATUS TYPES CD

BATCH UNITS FILE STATUS TYPES

WFP_CL_ALTER_ACTIONS_CD

ALTERATION ACTION ON CREDIT LINES IN
WEFP

WFP_CL_ALTER_REASONS_CD

CREDIT LINE CHANGE REASONS

WFP_CONDITION REASONS CD

UNIT CONDITION REASONS

WFP_DELAY DAY BASIS_CD

DELAY DAY BASIS

WFP_FEE_CALC_METHODS_CD

FEE CALCULATION METHODS

WFP_GL HEADER SEGMENTS

GL HEADER SEGMENTS (SUB CODE USED
FOR LABELS IN GLIS03)

WFP_LEVEL_IND_CD

SUB-TRANSACTION LEVEL INDICATORS

WFP_MONETARY _REASONS_CD

MONETARY TRANSACTION REASONS

WFP_PMT_MODES_CD

PAYMENT MODES OR METHODS

WFP_PMT REASONS CD PAYMENT REASONS
WFP_PMT STATUS TYPES CD PAYMENT STATUS TYPES
WFP_PMT TYPES CD PAYMENT TYPES

WFP_PRODUCER_STATUS -
TYPES_CD

WHOLESALE PRODUCER STATUS

WFP_RATE_REASONS_CD

RATE CHANGE REASONS

WFP_RESCHED REASONS CD

UNIT RE-SCHEDULING REASONS

WFP_TXN_ACTION_TYPES_CD

TRANSACTION ACTION TYPES FOR FLOOR
PLANNING

WFP_TXN_BALANCE_TYPE_CD

WHOLESALE FLOOR PLAN WFP WBT BAL-
ANCE CD CODES

WFP_TXN_SUB_TYPES_CD

TRANSACTION SUB TYPES (SUB CODE USED
FOR INDICATING BALANCE)

WFP_TXN_TYPES_CD

FLOOR PLANNING TRANSACTION TYPES

WFP_UNIT_ASSET TYPE_CD

WHOLESALE FLOOR PLAN ASSET TYPES

WFP_UNIT_COND_ACTION_CD

ACTION ASSOCITED WITH THE WFP UNIT
CONDITION
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Lookup Type: Description:

WFP_UNIT COND REASONS CD UNIT CONDITION REASONS

WFP_UNIT COND _TYPES CD UNIT CONDITION TYPES

WFP_UNIT STATUS REASONS CD | UNIT STATUS CHANGE REASON

WFP_UNIT STATUS TYPES CD UNIT STATUS TYPES

WFP_UNIT TYPES CD FLOOR PLAN UNIT TYPES

WFP_WCP_CEIL INDEX CD WHOLESALE FLOOR PLAN WFP WCP CEIL
INDEX CD CODES

WFP_WCP_MARGIN INDEX CD WHOLESALE FLOOR PLAN WFP WCP MAR-
GIN INDEX CD CODES

WFP_WCP_UNIT CD WHOLESALE FLOOR PLAN WFP WCP UNIT
CD CODES

WFP_WFR_FEE CALC - WHOLESALE FLOOR PLAN WFP WFR FEE

METHOD_ CD CALC METHOD CD CODES

WFP_WIB LEVEL IND CD WHOLESALE FLOOR PLAN WIB LEVEL INDI-
CATOR CODES

The following parameters apply to the WFP module:

e WFP MAX_CYCLES BACKDT
e WFP _REVERSE TXN_IND

Wholesale Floor Planning parameters are set up at the system level.

System level parameters
In setting up system level parameters for wholesale floor planning, you will need to know the
answer to the following two questions:

e The number of cycles back dated
e Which transactions use the reverse indicator?

Note

For more information about system level parameters, see this section of Parameters link
(Parameters Setup screen) in the Administration System Setup of this guide.

To set up the WFP parameters at the system level

1. On the Oracle Financial Services Lending and Leasing home screen, click the Setup
master tab.

2. Click the Administration bar link.

3. In the Administration Setup link bar, click the System drop-down link, then click
Parameters.

4. Click the Parameters drop-down link, then click System.

5. Onthe System Parameters Setup screen’s System Parameters section, search for and
set up the following parameters:
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Parameter:
WFP_MAX CYCLES BACKDT

Description:

WFP TRANSACTION NO.OF CYCLES BACKED

Parameter Value:

Type the number of cycles backed.
Parameter:
WEFP_REVERSE_TXN_IND
Description:

WFP REVRESAL OF TXN INDICATOR
Parameter Value:

Type the number of cycles backed.
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3.1

3.2

3. Index Rates

Introduction

The Index Rates maintains your organization’s history of periodic changes in index rates as it
applies to wholesale floor planning. It allows you to define the interest rate for the loans
extended to the producers by type of credit line. The index rate provides the base rate for a
credit line where:

interest rate = index rate + margin rate.
An index type can have different rates depending on the start date. For each index type, the

Index Rates section records the interest rate and the start date after which the rate is
applicable. If you do not want to use a variable index rate, you can use the flat rate index.

Index Rate Link

While you can add new rates for an existing index type, you cannot modify or delete existing
index rates.

To use the Index Rates link

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Index Rates

1. Inthe Index Types section, select the record you want to work with. Note: PRIME RATE
and FLAT RATE are the default, system defined rate types.

> DashBoard =l

> Originati
e Index Types dradd | /et | [Eview | o audt

Vieww Fomatv [} Freeze o Detach o @

Index Type Short Description  Description Enabled
i

» Servicing
» Collections

> WEP
" PRIME RATE PRIME RATE PRIME RATE
» Tools FLATRATE FLATRATE FLATRATE
Setup

Index Types

[ save andadd || [ save andstay | [ save and Return | 2 Retum

* Enabled @

; Index Rates dpadd | P Edt | 5 view | o Awit
evi~ Formatv B} Freeze i Detach rap ()]

Start Ot Rate Enabled
Ho data to display.

Note the Following:

e If you choose, use Search Criteria to limit the display of records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.

2. Inthe Index Types section, enter, view, or edit the following information

In this field: | Do this:

Index Type Select the index type (required).
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In this field: | Do this:

Short Enter the short description of the index rate type (required).

Description

Description | Enter the longer description of the index rate type
(required).

Enabled Select to enable the index rate type.

3. Inthe Index Rates section, select the record you want to work with.

Note the following:

e If you choose, use Search Criteria to limit the display of index rates records.

e If you are entering a new record, click Add.

4. In the Index Rates section, enter the following information

In this field: | Do this:

Start Date Enter the start date of the index rate. Note: This cannot be less than
current date (required).

Rates Enter the rate. Note: For a particular index type, multiple rates cannot
be entered in the Index Rates section with the same start date
(required).

Enabled Select to enable the index rate.

5. Click Save in the Index Types section.

For example,

Using the data in the sample graphic, let’'s assume the current date is February 5, 2009 (10/

30/2008).

The entries in the Index Rates section for a PRIME RATE include:

Start Date Rate
01/29/2009 3.0
10/16/2008 12.0
10/03/2008 8.0

In this scenario 8.0% will be the rate used by Oracle Financial Services Lending and Leasing
to compute interest on October 10, 2008.
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4. Fees

4.1 Introduction

The Fees link allows you to define the method of computing the various producer, credit line,
and unit level fees. You can define different fee calculations for a state, producer, and credit
line.

Note

The Fee Rules section on the Fees link displays all the system defined balance types,
even those disabled on the Balance Types screen. This is necessary for Oracle Financial
Services Lending and Leasing to retain the fee rules associated with the balance type in
case any are already associated with any existing units.

4.2 Fees Link

To use the Fees link

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Fees.

ORACLE # Welcome, VAVAIDYA ~ Ies?
Financial Services Lending and Leasing N

ces x Close
» DashBoard E -
> Origination
i Fee Balance Types Elvien
RSeiany Vieww Fomat~ B
> collections = =
© wrp AL PRODUCER
AUD CREDIT LINE
> Tools o
Setup 2 v
- s ON SUFFICIENT FUNDS PRODUCER
i om UNIT OTHER uny
P8 PRINCIPAL BALANCE unar
sve UNIT SERVICE FEES unr
Fee Rules dradd | At 2 hudt
View~ Format~ Freeze i Detach Wrap 51}
State Producer  : liame Credit Li start Dt End ot Enabled cale
02/11/2016 12314000 ¥
ARMED FORCES AMERICANS (EXCEPT CANADA) AL 1:1 01/05/2016 12/31/4000 v [y
Lasi AL 1:1 04/03/2016 12/31/4000 Y PER|
AL AL AL 1241572015 v P
4 A AL AL 1271972015 v P
uw AL AL 12/14/2015 v P
ALL AL 12152015 Y P
ALL AL DEI0 : DEMO VEHICLES 1201972015 12142015 u PERI
AL AL AL 120232015 12(31/3000 v unr
AL AL AL 12/30/2015 12/31/4000 v PERI T
»
Fee Rules
B saveandadd | & save and stay || B save and Return | Ga Retum
< state . o s B ree 000
Prod ® Fee
art ot 02/11/2015 B

1. Inthe Fee Balances Types section, select the record you want to work with.

Note

If you choose, use Search Criteria to limit the display of instrument records.

2. Inthe Fee Balances Types section, view the following information:

In this field: View this:

Fee The system defined fee types applicable for WFP (display only).

Description The balance description of the fee type (display only).
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In this field:

View this:

Level

View the balance type level at which a fee is applicable: PRODUCER,
CREDITLINE, or UNIT (display only).

3.

column.

Note the following:

In the Fee Rules section, select the record you want to work and click Show in the Details

e If you choose, use Search Criteria to limit the display of the fee rule records.

— If you are entering a new record, click Add.

— If you are changing an existing record, click Edit.

4. In the Fee Rules section, enter, view, or edit the following information:
In this field: Do this:
State Select state initials (required).

Producer #: Name

Select the producer (optional).

Credit Line Select the credit line (optional).

Start Date Start the date from when the fee rule is applicable (required).

End Date Start the date till which the fee rule is applicable.
A blank field indicates no end date (optional).

Enabled Select to enable this fee rule.

Calculation Select the calculation method. If the calculation method is FLAT,

Method then Fee% field should have the value 0.0 and the Fee Amount -
Maximum field would have the same value as that in the Fee
Amount - Minimum field. Oracle Financial Services Lending and
Leasing uses the Fee Amount - Minimum field for fee calculation
(required).

Fee% Enter the fee percentage (required).

Fee Amount Mini-
mum

Enter the minimum fee amount that would be charged to the pro-
ducer (required).

Fee Amount Maxi-
mum

Enter the maximum fee amount that would be charged to the pro-
ducer (required).

5. Click Save on the Fee Balance Types section.

FLEXCUBE WFP supports the following types of fees and calculation methods:

Description Level Calculation Methods supported
NON SUFFICIENT PRODUCER FLAT

FEES

PRODUCER PRODUCER FLAT

ANNUAL FEES
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Description Level Calculation Methods supported

CREDIT LINE AUDIT | CREDIT LINE FLAT

FEES

LATE CHARGE UNIT FLAT
PERCENTAGE OF PAYMENT DUE
PERCENTAGE OF BALANCE PAYMENT
UNIT CHARGE

UNIT SERVICE FEES | UNIT FLAT

UNIT OTHER FEES UNIT FLAT

4-3
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5.1

5.2

5. Pricings

Introduction

The Pricing link records the various pricing plans the financial institution offers to its
producers. By default, sample pricing plans are available while setting up WFP. You can then
modify and add plans to this screen. At least one pricing plan should be enabled.

Pricing Link

Oracle Financial Services Lending and Leasing takes the index rate from the Index Rates
screen for the code in the Margin Index field and adds the value of the Margin Rate to
calculate the credit line’s interest rate.

You cannot define different pricing policies for different producers (since producer is not a part
of Policies setup). However, it is possible to overcome this by having two different credit lines
on the Pricing screen, NEW-PRODUCER A and NEW-PRODUCER B, with the same unit type
NEW.

To use the Pricing link

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Pricings

ORACLE 3 Sr—— =)
Financial Services Lending and Leasing

pricngs 3 close

> DashBoard

Pricing Details Fadd | Lo | Elvien | £ auie

Indax Start Ot Endot Ensblad Initial Adv % Term

PRIME RATE
PRIME RATE
PRIME RATE
PRIME RATE
PRIME RATE
PRIME RATE
PRIME RATE
PRIME RATE
PRIME RATE
PRIME RATE

12/31/4000 v 100.0000 2
12/33/4000 ¥ 100.0000 2
12/31/4000 ¥ 100.0000 2
12/31/4000 ¥ 100.0000 2
12/31/4000 v 100.0000 7
12/33/4000 ¥ 100.0000 o
12/31/4000 ¥ 100.0000 7
12/31/4000 ¥ 100.0000 2
12/31/4000 v 75.0000 2
12/33/4000 ¥ 100.0000 2
12/31/4000 ¥ 300000 12
12/31/4000 ¥ 700000 4
12/31/4000 v 700000 4

PRIME RATE
PRIME RATE

TesT1 TesTL PRIME RATE 1242212015

Pricing Details

start bt 3

In the Pricing Details section, select the record you want to work with and click Show in the
Details column.

e If you choose, use Search Criteria to limit the display of records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.

1. In the Pricing Details section, enter, view, or edit the following information:

In this field: | Do this:

Code Enter the pricing code (required).

Credit Line Enter the credit line. Each entry in the list should be unique (required).

Description | Enter a description of the credit line (required).
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In this field:

Do this:

Unit Select the unit type. This describes the type of unit to which the pricing
applies (required).

Start Date Enter the start date. This is the date after which the pricing plan would
be in use and available in maintenance. Note: The start date of a pricing
plan cannot be less than the current date (required).

End Date Enter the end date. This is the date after which the pricing plan would
not be available. Note: The end date cannot be less than the current
date or start date (optional).

Enabled Select to enable the pricing policy.

Initial Adv% | Enter the initial advance percent. This indicates what percent of the
value of the unit is given to the producer as an advance (loan). For
example, if the value of a new vehicle is $10,000 and the loan given to
the producer is $8,000 then the initial advance percent is 80 percent
(optional).

Term Enter the total term in months. This indicates the maximum term (in
months) of the credit line (optional).

Current Yr Enter the percent of outstanding principal which need tobe recovered

Curtailment | from the producer each month in the current year.

Prior Year Enter the prior year curtailment percent (optional).

Curtailment

Margin Rate | Enter the margin rate. The interest rate equals the index rate plus mar-
gin rate. Index rate is the applicable interest rate for the selected index
type (optional).

Ceiling Select the ceiling index code. This indicates the index on which the

Index interest rate ceiling would be based (optional).

Ceiling Rate | Enter the ceiling margin rate. This defines the ceiling for interest. The

ceiling rate equals the ceiling index rate plus the ceiling margin rate. For
example, if the index rate is three percent, the margin rate is one and a
half percent, and the ceiling rate is five percent, then the interest rate is
four and a half percent. If the index rate increases to four percent, the
interest rate will be five percent and not five and a half percent
(optional).

2. Click Save in the Pricing Details section.
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6.1

6. Contracts

Introduction

The Contract link allows you to define the terms and conditions of your contracts. Contracts
can be defined according to company, branch, and type of unit. You can add new contracts
and modify the existing ones.

6.2

Contracts Link

Oracle Financial Services Lending and Leasing selects which instrument to offer based on

whether:

The instrument company/ branch matches the producer company/ branch. Note: We

recommend setting up an instrument where the company / branch is ALL/ ALL to ensure
proper performance in Oracle Financial Services Lending and Leasing

To use the Contract link

The contract date at unit level should be between the instrument start and end date
The instrument is enabled.

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Contracts

ORACLE'

Financial Services Lending and Leasing

# Welcome, VAVAIDYA + - ST ]

> DashBoard
> Origination
> Servicing
> Collections
> WP

> Tools
setup

Setup
Administration

> Products
WP
Index Rates
Fees
Pricings
Contracts
Balances
Transactions
Spreads

‘

Contracts .

Instrument

B save and add

View v Formatv [ Freeze i Detach rap W
Name Description Company Branch Start Dt End Dt Enabled Unit Start Basis
of2016 ¥ 3
FPL3 TEST2 oz g 1/15/1993 12/31/4000 ¥ DEMONSTRATOR VEHICLES £
TESTS TESTS 1804 IrHq /1712015 N ClEs £
FI_WEP_INST _WFP_INS usn1 ustg /211582 12/22/99%9 Y £
TEST NEW VEHICLE IS usn1 uskg 11172000 2/11/4000 ¥ £
L1 Floor Plan Instrument 1 US01 usHo 12/07/1993 12/31/a000 ¥ 3
FPL2 Floor Plan Instrument 1 US01 USHQ 12/07/1993 12/31/4000 Y E
TESTL TESTI 304 HQ 1142015 N e
Instrument
* Hame *Start Basis  EFFECTIVE DATE
Descrption
* Company
* Branch
*startot 02112018 B
EndDt &
enabled ¥ Max Rate Increase / Year 00000
*Unit * Max Rate Dearease | Year | 00000
Instrument Balance Types
View~ Formatv [ Frecze ] Detach Wrap ]
Balance Type

o data to display.

Payment Tolerance  Writeoff Tolerance
Amt

000
000
000
10.00
10.00
10.00
500
000

* Accrual Base Days

(3] Close.
drad | /et | Evien | £ audt
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000 0.0000
000 0.0000
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10.00 10.0000
10.00 10000
10.00 3.0000
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In the Instrument section, select the record you want to work with and click Show in the
Details column.

1.

If you choose, use Search Criteria to limit the display of records.
If you are entering a new record, click Add.
If you are changing an existing record, click Edit.

In the Instrument section, enter, view, or edit the following information:

In this field:

Do this:

Name

Enter the unique name of the instrument (required).
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In this field:

Do this:

Description | Enter the instrument description. This entry should briefly describe the
instrument (required).

Company Select the company for which the instrument is applicable (required).

Branch Select the branch of the company for which the instrument is applicable
(optional).

Start Date Enter the start date. This is the date after which the instrument is in use
and is available on the Wholesale Floor Planning Maintenance form
(required).

End Date Enter the end date after which the instrument is invalid and unavailable
on the Wholesale Floor Planning Maintenance form. While this field
can be empty, it cannot be less than the current date or start date
(required).

A blank field indicates no end date (optional).

Enabled Select to enable the contract instrument.

Unit Select the unit type (required).

This field links the policies to contracts. There should be at least one
enabled contract for every unique unit type (required).

Start Basis Select the accrual start date basis. This indicates the date from which
the interest rate would be calculated. For example, a start basis that
equals the payment date implies that the interest rate calculation starts
with the first payment date (required).

Payment Enter the payment tolerance amount. This defines the acceptable

Tolerance shortfall in the monthly payment in dollars for which no penalty would

Amount be imposed (required).

Writeoff Tol- | Enter the writeoff tolerance amount. This is the tolerance acceptable

erance while a unit gets paid off. The unit will be considered paid even if pay-

Amount ment is falling short of actual due by this amount (required).

Pmt Toler- Enter the payment tolerance percent. This defines the acceptable per-

ance% cent of the monthly payment due which no penalty would be imposed.
For example, the tolerance can be set for 95 percent of payment due
(required).

Late Charge | Enter the late charge grace days. This is the number of days after the

Grace days | payment due date during which no late fee would be charged
(required).

# Rate Enter the number of rate changes in a year. This is the maximum num-

Changes/ ber of times the rate can be changed in a year for a unit. Note: The

Year number of rate changes in a year cannot exceed the number of rate
changes for the life of the contact (required).

Max Rate Enter the maximum rate increase in a year. This is the ceiling limit for

Increase rate increases in a year (required).

Year
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In this field:

Do this:

Max Rate Enter the maximum rate decrease in a year. This is the floor limit for

Decrease rate decreases in a year (required).

Year

Accrual Select the accrual base days. This is the number of days the instru-

Base Days ment assumes in a year for interest computation: 360, 365, or 366. If
the accrual base is selected as 365, the interest computation would be
based on actual days (365) and the base would be 365. However, in
this case, if the year happens to be a leap year and the actual day’s
computation includes the month of February, then the additional day of
leap year is not considered (required).

Accrual Enter the accrual start days. This is the number of days after which

Start Days interest accrual starts once the instrument is in use (required).

Refund Tol- | Enter the refund tolerance amount. If the refund due to the producer is

erance more than this, the tolerance amount is refunded. Note: You cannot

Amount complete this field if the Refund Allowed box is selected (required).

Dlq Grace Enter the delinquency grace days. This is the number of days after the

Days payment due date during which the account will not be considered
delinquent (required).

# Rate Enter the number or rate changes in life. This is the maximum number

Change Life | of times the rate can be changed during the life of the contract
(required).

Max Rate Enter the maximum rate increase in life of loan. This is the ceiling limit

Increase for rate increase during the entire life of the contract (required).

Life

Max Rate Enter the maximum rate decrease in life. This is the floor limit for rate

Decrease decrease during the entire life of the contract (required).

Life

Refund If selected, this check box indicates this instrument allows a refund in

Allowed case the producer pays in excess of what is due (required).

The Instrument Balance Types section allows you to define the balance type for the selected

instrument at the producer, credit line, or unit level.

2.

In the Instrument Balance Types section, select the record you want to work with.

e If you choose, use Search Criteria to limit the display of records.

— If you are entering a new record, click Add.

— If you are changing an existing record, click Edit.

3. Inthe Instrument Balance Types section, enter, view, or edit the following information:
In this field: Do this:
Select If selected, indicates that this is the current record.

Balance Type

Select the balance type (required).

Level

View the level indicator. This entry is based on the selected
Balance Type and is non-editable (required).
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In this field: Do this:

Include Monthly Due ? | Select to compute the minimum monthly payment.

4. Click Save in the Instrument section.
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7.1

7.2

7. Balances

Introduction

The Balance Types link displays the various types of balance types computed for each
producer (or “dealer”) set up in the WFP module. The balances defined in the Balance Types
section are fixed, system defined, and set up during WFP installation. You cannot add or
modify any balance types. However, you can choose not to use a balance type by clearing its
Enabled check box.

Balances Link

To view the Balance Types link
On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Balances

1. In the Balance Types section, select the record you want to work with.

d Leasing

Note

If you choose, use Search Criteria to limit the display of records.

2. In the Balance Types section, view the following display only information:

In this field: | View this:

Type The transaction type.

Code The balance code.

Description | The description.

Level The balance level. This indicates whether the balance is computed at
PRODUCER, CREDIT LINE, or UNIT level.

Enabled Select to enable the balance types. When this check box is clear, Oracle
Financial Services Lending and Leasing will not compute this balance
from that date on for all new producers, credit lines, or units.
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Note

The balance types PRINCIPAL BALANCE and INTEREST should be enabled at the UNIT
level.
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8.1

8.2

8. Transactions

Introduction

The Transactions records the system defined, consolidated list of transaction codes available
in the WFP module.

The transaction codes defined on this screen are fixed, system defined, and set up during
WEFP installation; you cannot modify them. However, you can choose not to use a transaction
code by clearing its Enabled check box. You can also choose which transactions affect the
general ledger by selecting the GL check box.

The transaction codes defined here are available on the Wholesale Floor Planning
Maintenance form.

Note

If any transaction code is disabled on the Transaction Codes screen, it may have an im-

pact on the spreads if the disabled transaction code was listed in the Spread Details sec-
tion on the Spreads screen. Oracle Financial Services Lending and Leasing would not be
able to prevent allocation of payment to this code in spite of it being disabled.

Transaction Codes Link

To use the Transaction Codes link

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >

WFP > Transactions

ORACLE = Welcome, VAVATDYA v o
Financial Services Lending and Leasing .

> DashBoard Transactions x

» Origination "
2 Transaction Codes 2t || Eview || 7 nuat
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DUEDATEHISTORY FOR UNITS  DUE DATE POST

(il FAANL ANNUAL FEE FeE PRODUCER AU
FBANL ANNUAL FEE - BILLED FEE
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FEE
FeE
FeE
FeE
FeE

Code PITOUE SubType DUEDATE o
* Description | PMT DUE DATE Action POST Enabled @
Type DUE DATE HISTORY FOR UNITS Hanual

Transaction User Access Definition add | St | [H ve Audit
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1. In the Transaction Codes section, select the record you want to work with.
e If you choose, use Search Criteria to limit the display of records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.
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2. Inthe Transaction Codes section, enter, view, or edit the following information

In this field: | Do this:

Code Enter transaction type code. This is a system defined code for the
transactions. The first letter of the code indicates the type of task the
transaction performs:

P — payment

F —fee

O - charge off

Q - reverse charge off
R —reverse

W — waive

V — reversal of waived transaction (required).

Description | Enter the description associated with the Transaction code. This is a
system defined field that can be modified by users (required).

Type Select the transaction type. This field maps the transaction code to
into Transaction types (required).

Sub Type Select the sub type (required).

Action Select the action type. For more information about the Action field, see
the following section,

A Note about the Action Field. Note: If a transaction code has an
action of POST, WAIVE, or CHARGEOFF, then a REVERSE action
should also be associated with this code (required).

Manual Select to allow users to post these transactions on the Wholesale
Floor Planning Maintenance form.

GL Select to post the transaction to the general ledger when performed.

Enabled Select to enable the transaction code.

Note: Transactions codes which are not selected are not available in
the LOVs on the WFP maintenance screens.

Note

Transaction codes of transaction type INTEREST and PRINCIPAL cannot have a cleared
Enabled check box.

3. Click Save in the Transaction Codes section.

A Note about the Action Field

The Action field indicates how the transaction code affects the account. The standard actions
associated with the various transaction codes are as follows:

e POST
e BILLING
e CHARGE-OFF

8-2 ORACLE



e WAIVED
e REVERSE
e VOID

Most Type field and Sub Type field combinations have an action and a reverse action
associated with them. Each Type field, Sub Type field, and Action field combination is
identified using a unique transaction code.

For example,

The Type FEE and Sub Type PRODUCER ANNUAL FEES combination has the eight following

actions associated with it, each having a unique transaction code:

Note that there are four actions and four reverse actions associated with the Annual Fee.

Fee Waived

Code Description Type Sub Type
FAANL Annual Fee Fee Producer
Annual Fees
RFAANL Reversed - Annual Fee Producer
Fee Annual Fees
FBANL Annual Fee - Billing | Fee Producer
Annual Fees
RFBANL Reversed - Annual Fee Producer
Fee Billing Annual Fees
OFAANL Annual Fee - Char- | Fee | Producer Chargeoff
geoff Annual Fees
QFAANL Reversed - Annual | Fee Producer
Fee Chargeoff Annual Fees
WFAANL Annual Fee - Fee Producer
Waived Annual Fees
VFAANL Reversed - Annual Fee Producer

Annual Fees

Most of the Type and Sub Type combinations would have these eight transaction codes.
However, there are some transactions such as Payment, Rate Change, Rescheduling Unit,

Void, and Status Change which may not have all eight codes.

Details of the transaction codes would be listed in the seed data.
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9.2

9. Spreads

Introduction

The Spreads link records the order in which Oracle Financial Services Lending and Leasing
allocates a payment spread for a spread transaction code. You can add to or disable the seed
data sample spreads on this screen as you choose. However, you must verify that there is no
residual dollar amount, as Oracle Financial Services Lending and Leasing refunds the
producer any balance not used in the spread.

Spreads Link

Spread details uses the transaction codes listed in the transaction codes setup. In case any
of the transaction codes are disabled from transaction codes setup, Oracle Financial Services
Lending and Leasing would not remove that code from spread details. You must manually
verify that such codes are removed from the spread details as well.

To use the Spreads link

On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup >
WFP > Spreads.

ORACLE’ & Welcome, VAVAIDYA v o
Financial Services Lending and Leasing

Close
> DashBoard el d L

> Origination 5
g Spread Codes o add | Pedt | [ view | o auit
View~ Formatv [ Freeze G Detach rap (o))

> Collections Code Desciption ==
> WEP

> Servicing

nabled

7 Touls oA PRODUCER ACTIVE SPREAD PRODUCER
Setup u UNIT ACTIVE SPS I
= UAF UNIT ACTIVE SPREAD - FEE ONLY (g
Setp U3} UNIT ACTIVE SPREAD - INTEREST ONLY T
> Administration wap UNIT ACTIVE SPREAD - FRINCIPAL ONLY it
> Products

[t E
N ¥
ca CREDITLINE ACTIVE SPREAD CREDIT LINE Y Y
¥ ¥
Y ¥
[ ¥
[ ¥
[ Y

wFp

Index Rates Spread Codes

il B saveandadi | B saveand stay | [ save and Retum | GaRetum

Pricings

Contracts Code * Default
Balances
Transactions
Spreads *Level UNIT

q Desaiption *Enabled @

Spread Details o add | SEdt View | 2 Audt
Viewv Formatv [ Freeze B Detach rap o]

Tn Code Description seq Enabled
Mo data to display

1. Inthe Spread Codes section, select the record you want to work with.
e If you choose, use Search Criteria to limit the display of spread code records.
— If you are entering a new record, click Add.
— If you are changing an existing record, click Edit.

2. Inthe Spread Codes section, enter, view, or edit the following information:

In this field: | Do this:

Code Enter an unique code for the spread (required).

Description | Enter a description for the spread code (required).
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In this field: | Do this:

Level Select the indicator to define the level at which the fee is applicable.
Note: While making changes on the Spreads screen, make sure that
there is one and only one enabled spread code for each level
(required).

Default Select to indicate this a default spread code.

Enabled Select to enable this spread code.

The Spread Details section records the details of the transaction codes to which Oracle
Financial Services Lending and Leasing applies the spread, as well as the priority for applying
the spread over multiple transactions. At least one enabled transaction code should be
available for each spread.

3. Inthe Spread Details section, select the record you want to work with.

e If you choose, use Search Criteria to limit the display of spread details records.

— If you are entering a new record, click Add.

— If you are changing an existing record, click Edit.

4. Inthe Spread Details section, enter, view, or edit the following information:

In this field: | Do this:

Txn Code Select the transaction code (required).

Description | View the transaction code description as set up on the Setup master
tab’s Transaction Code screen (display only).

Seq Enter the sequence in which the spread would be applied to various
Txn codes (required).

Enabled Select to enable the this spread detail.

5. Click Save on the Spread Codes section.
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Appendix A: Late Fee Methods Definitions

FLAT AMOUNT

FLAT AMOUNT charges a flat (fixed amount) fee when an account becomes overdue.

For example, if the FLAT AMOUNT late fee is set at $25, and the account is $900 overdue,
then the late fee assessed will be $25. For each month the account is overdue, regardless of
the amount, the late fee assessed will be $25.

PERCENTAGE OF PAYMENT DUE

PERCENT OF PAYMENT DUE charges a late fee based on a percentage of the part of a
payment due that remains to be paid.

For example, if the PERCENT OF PAYMENT DUE late fee is set as 10%, and if only $90 of a
$200 standard payment is due, then the late fee will be $9 (10% of 90).

If $3000 on a loan with a standard payment of $200 is due, the late fee will be $20 (10% of
200). This is because the computed late fee is based only on the payment due for that month
-- not the accumulated due amount.

If the stated monthly payment is $300 and account is delinquent for 3 months ($900), then
every month the late fee is computed only on the amount due for that month ($300 or part of
$300) -- not on $900.

PERCENTAGE OF STANDARD PAYMENT

PERCENTAGE OF STANDARD PAYMENT charges a late fee based on the standard monthly
payment, regardless of the current amount due.

For example, if you set 10% as the PERCENTAGE OF STANDARD PAYMENT late fee, the

standard payment amount was $500, and the account was due for $2000, then the late fee
will be $50 (10% of 500). In other words, every month the system computes the late fee using
monthly standard payment amount ($500), irrespective of the amount paid by the customer.

If the customer pays $400 out of $500, the system still computes the late fee using $500, and
not on $100.

FLAT AMOUNT PYRAMID LAW

FLAT AMOUNT PYRAMID LAW prevents the pyramiding of “flat” late fees. If an account is
overdue, then the system assesses a flat (fixed amount) late fee. However, if the standard
payment is made the following month, then a new late charge will not be created, even if the
payment made does not fulfill the current amount due.

For example, if a customer is assessed a late fee of $25 for 1/2005, and makes his $200
standard payment in 2/2005, that person cannot be assessed a new $25 late fee for 2/2005
(even though his payment only fulfilled the amount owed for 1/2005).

If a customer makes a payment of just $199 in 1/2005 (an amount that does not fulfill the
standard payment), then the customer could also be assessed a $25 late fee for 2/2005.

If the customer makes a payment of $199 in 2/2005 (an amount that does not fulfill the
standard payment), then the customer could be assessed a late fee for 2/2005.
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PERCENTAGE OF PAYMENT DUE PYRAMID LAW

PERCENTAGE OF PAYMENT DUE PYRAMID LAW prevents the pyramiding of “percentage of
payment due” late fees. If an account is overdue, then the system assesses a fee based on
what part of a payment remains to be paid. However, if the standard payment is made the
following month, then the system will not create a new late charge, even if the payment made
does not fulfill the current amount due.

For example, if the PERCENTAGE OF PAYMENT DUE PYRAMID LAW late fee is set as 10%,
and if only $90 of a $200 standard payment was due, then the late fee would be $9.

If $3000 on a loan with a standard payment of $200 was due, the late fee would be $20.
However, if a customer was assessed a late fee of $9 for 1/2005, and makes his $200
standard payment in 2/2005, then that person cannot be assessed a new late fee for 2/2005
(even though his payment only fulfilled the amount owed for 1/2005).

If the customer makes a payment of $199 in 2/2005 (an amount that does not fulfill the
standard payment), then the individual could be assessed a late fee for 2/2005.

Note

The system computes the late fee based on the payment due for only that month and not
the accumulated due amounts.

If the stated monthly payment is $300 and account is delinquent for 3 months ($900), then the
system computes the late fee every month with the amount due for that month ($300 or part
of $300) and not on $900.

PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW

PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW late fee prevents the pyramiding
of “percentage of standard payment” late fees. If an account becomes overdue, then the
system assesses a fee based on the standard monthly payment, regardless of the current
amount due. However, if the standard payment is made the following month, then the system
will not create a new late charge, even if the payment made does not fulfill the current amount
due.

For example, if the PERCENTAGE OF STANDARD PAYMENT PYRAMID LAW late fee is set
as 10%, and the standard payment is $200, then $20 (10% of 200) is owed. If only $90 of a
$200 standard payment was due, then the late fee would still be $20.

If $3000 on a loan with a standard payment of $200 is due, the late fee will be $20, since the
fee is calculated based on the payment due -- not the total outstanding amount due.

However, if a customer is assessed a late fee of $20 for 1/2005, and makes the $200 standard
payment in 2/2005, that person cannot be assessed a new late fee for 2/2005, even though
the payment only fulfills the amount owed for 1/2005. If the customer makes a payment of
$199 in 2/2005 (an amount that does not fulfill the standard payment), then the system could
assess a late fee for 2/2005.
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Appendix B: Rounding Amounts and Rate Attributes

Rounding Amounts

Generally in the lending industry, computed amounts (interest, fees, costs, and so on) are
rounded to the second decimal place. However, there are occasions where the rounding of
the computed amounts has to be carried out using different methods. Oracle Financial
Services Lending and Leasing supports the rounding, raising, or cutting off of calculated
amounts.

Rounding will increase the resulting amount to the next number up to the second decimal,
based on the value of third decimal.

Raising will always increase the resulting amount to the next number up to the second
decimal.

Cutting off will always cut the number after the second decimal.

You can choose the rounding method you want to use by setting the parameter value for the
system parameter CMN_AMOUNT ROUND_METHOD in setup screen (Setup >
Administration > System > System Parameters > System tab).

You can choose the rounding factor you want to use by setting the parameter value for the

system parameter CMN_AMOUNT ROUND_FACTOR in setup screen (Setup >
Administration > System > System Parameters > System tab).

Examples of how resulting amounts differ by RAISE, ROUND, and CUTOFF:

Example 1: Amount: 234.136

Method Result
Round 234.14
Raise 23414
Cutoff 234.13

Example 2: Amount: 234.134

Method Result
Round 234.13
Raise 234.14
Cutoff 234.13

Example 3: Amount: 234.1319999

Method Result
Round 234.13
Raise 234.14
Cutoff 234.13

ORACLE



Note

The system rounds only calculated amounts (calculated fees, calculated payment, and so
on) and not user-entered amounts.

Rate Attributes

The system supports the rounding of the index rate to keep the rate calculation as simple as
possible for the customers. The general practice is to round the rate to nearest eighth (1/8th)
(to keep the index rate in the multiple of .125) or fourth (1/4th) (to keep the index rate in the
multiple of 25). The system rounds only the index rate and not the margin or final rate. You
can define the index rounding method on the Product tab’s Product Definition screen for
variable rate line of credits.

Note

Index rounding does not apply to fixed rate loans.

The system currently supports the following rounding of methods.

1. NO ROUNDING TO INDEX RATE
2. INDEX RATE ROUNDED TO NEAREST .25
3. INDEX RATE ROUNDED TO NEAREST .125

NO ROUNDING TO INDEX RATE: Select this method for no rounding.

INDEX RATE ROUNDED TO NEAREST .25: Select this method to round up to 1/4th (to keep
the index rate in the multiple of .25).

Examples
Type Value
Current rate: 5.125

Round of rate: 5.25

Type Value

Current rate: 5.124

Round of rate: 5.00

INDEX RATE ROUNDED TO NEAREST 0.125: Select this method to round up to 1/8th (to keep
the index rate in the multiple of 0.125).
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Examples:

Type Value
Current rate: 5.325
Rate rounded to: 5.375
Type Value
Current rate: 5.312
Rate rounded to: 5.250
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C.1

C.2

Appendix C:System Parameters

Introduction

System defined parameters help in configuring system specific data, User-access, location of
system files; reports related URLs and other administration controlled data. These are
essential to be configured during installation and some of them by nature of application will
have to be reviewed and maintained in a regular and periodic manner.

Following are the types of parameters are used in OFSLL system depending on the areas of
the system that these would apply and impact:

System Parameters

Organization Parameters

Company Parameters

Other Parameters

Note

All the above parameters can be controlled (enabled/disabled) only by System Adminis-
trators, and users with Admin/Super User privileges who would be involved in setting-up
OFSLL system.

System Parameters

System parameters apply to the entire system. They relate to the overall processing of the
system like application server file locations, data purging configurations and so on. Table
below details the list of system parameters with their description and pre-defined values.

Parameter Description

ACA_DLQ_AMT_EX- This parameter is used to exclude delinquency amount for
CLUDED account ACH

ACA_PAYMENT_AU- This parameter is used to control posting directly from the
TO_LOAD ACH file that has been created for customer payments.

Input parameter value is Boolean (Yes/No). If the parame-
ter is set to Y’, the system automatically creates payment
batches for the payments in the ACH file and posts them
on the day of payment.

ACA_PRENOTE_DAYS This parameter is used to define the number of days the

prenote should be initiated for customer ACH (Automated
Clearing House) accounts. Input parameter value is

numeric.
ACA_PRE_PROCESS - This parameter is used to specify the number of days
DAYS before draft day for Account ACH process. Input parameter

value is numeric.

ACH_PAYEE_PRENOTE_- | This parameter is used to define the number of days for
DAYS prenote to occur for Producer or Vendor ACH accounts.

Input parameter value is numeric

C-1 ORACLE



Parameter

Description

ADMIN_SERVER_URL

This parameter is used to define the admin server URL

ADR_DIRECTORY

This parameter is used to define the Oracle Directory
Object Name for ADR file location

ADR_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle Directory
Object Name for ADR file location

AGE_APPROVED_CON-
DITIONED_DAYS

This parameter is used to specify the number of days by
which an application in ‘Approved’ or ‘Conditioned’ status
is treated as Aged Application. Input parameter value is
numeric with no upper limit.

AGE_CONTRACT_DAYS

This parameter is used to specify the number of days by
which a contract is treated as Aged Contract. Input param-
eter value is numeric with no upper limit.

ASC_COL_SER_ENA-
BLED_IND

This parameter is used as the Collection Servicing Ena-
bled Indicator

CAC_DIRECTORY

This parameter is used to define the Oracle Directory
Object Name for CAC file location

CAC_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle Directory
Object Name for CAC file location

CHECK_PRINT_PREVIEW

Using this parameter we can allow preview of application in
pdf form before printing. Input parameter value is Boolean
(Yes/No).

CMN_AMOUNT_ROUND_
FACTOR

This parameter is used to define the rounding factor for
applicable fields (in this case calculated amounts). Input
parameter value is ‘ROUND AMOUNT TO 2 DECIMALS'.
Currently system supports rounding factor 2 only.

CMN_AMOUNT_ROUND_
METHOD

This parameter is used to define the amount round method
during system set-up and would be applicable for all calcu-
lated amounts (calculated fees, payment etc.) across the
application. Input values are ROUND, RAISE and CUT-
OFF:

ROUND: Rounded to nearest number higher or lower
RAISE: Rounded to the nearest higher number

CUTOFF: Truncate the digits without rounding or raising

CMN_APP_ACC_TI-

This parameter is used to set the Application or Account

TLE_FN_LN title in one of the formats — First/Last Name or Last/First
Name. Input parameter value is Boolean (Yes/No). If Yes is
chosen, title would be in the format — First/Last Name, else
the other option.

CMN_APP_- This parameter is used to set the Application Server Home

SERVER_HOME

Directory. Input parameter value is user defined.

CMN_CURRENT_MOD-
EL_YEAR

This parameter is used to default the Current Model Year.

CMN_DEBUG_LEVEL

This is the Common Debug Level
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Parameter

Description

CMN_DEBUG_METHOD

This parameter allows to define the location to which
generic debug logs (other than Alert/Warning and GRI) are
to be written. If set to ‘ADVANCE_QUEUFE’, system writes
the logs in Logs table and if set to ‘UTL_FILE’, system gen-
erates the alert log file.

CMN_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing files/documents are to be pro-
cessed. If set to Y’, system processes the data to/from
LOB and if set to ‘N’, system processes the data to/from
FILE.

The same is used by the batch jobs available in SET-IFP
(input file processing) Batch Job Set.

CMN_GL_POST DT

This parameter is used to specify the General Ledger Post-
ing date. If scheduler is enabled, it automatically updates
this to current system date. Else Admin User would need
to set this date manually to ensure correct posting dates in
GL.

CMN_HTTP_PROX-
Y_PORT

This parameter is enabled to specify the port to be used for
outgoing HTTP connections. Input parameter value is user
defined.

CMN_HTTP_PROXY_-
SERVER

This parameter is enabled to specify the proxy server to be
used for outgoing HTTP connections. Input parameter
value is user defined. There exists an interdependency of
this parameter with CMN_HTTP_PROXY_PORT men-
tioned above.

CMN_INT_360_ACCRU-
AL_DAYS_MTHD

This parameter is used to specify the interest accrual
method for 360 days, to be used by the System for all cal-
culations with interest. Currently two methods are sup-
ported. Input parameter value is ‘US’ or ‘EU’ representing
American and European method of interest accrual for 360
days.

CMN_TEST_TOOL_LOG-
GING

This parameter is used to set testing tool logging parame-
ter

CMN_SCHEMA_ID

This is used to specify the schema identifier for all users.

CMN_SCHEMA_NAME

This is used to specify the Oracle User Name for a specific
schema. Input parameter value is user defined.

CMN_SCHEMA_PASS-
WORD

This captures the password for Oracle, for the specific
schema. Input parameter value is user defined. This
parameter need not be enabled when in Oracle Network.

CMN_SERVER_HOME

This parameter captures the Server Home Directory. Input
parameter value is user defined.

CMN_-
SERVER_TEMP_DIR

This parameter is used to specify the temporary directory
on the server along with the path. Input parameter value is
user defined.
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Parameter

Description

CMN_SER_ENVIRON-
MENT_FILE

This parameter captures the environment file (and its path)
for running the Operating System commands from Job
Service. Input parameter value is user defined.

CMN_WALLET_PASS-
WORD

This parameter is used to specify the common wallet pass-
word. Input parameter value is user defined.

CMN_WALLET_PATH

This parameter is used to specify the common wallet path
for oracle database. Input parameter value is user defined.

CPP_NO_OF_PROMISES

This parameter is used to define the maximum number of
promises/chances allowed for a customer who is delin-
quent and promises to pay. Input parameter value is
numeric with no upper limit.

CPP_PROMISE_HELD -

This parameter is used to define the maximum number of

DAYS days after the promises made by the customer to pay are
broken to initiate further actions. Input parameter value is
numeric with no upper limit.

CRD_CHS BIN This parameter holds the value of the credit card BIN

(Bank Identification Number for Credit Cards), for CHASE
interface. Input parameter value is user defined.

(P.S: OFSLL supports CHASE interface for credit card pay-
ments processing)

CRD_CHS_CUR_CODE

This parameter is used to specify the currency code of the
transacting currency for CHASE interface. Input parameter
value is user defined.

CRD_CHS_DIR_PATH

This parameter is used to specify the directory path for
CHASE payment interface for Credit Cards. Input parame-
ter value is user defined.

CRD_CHS_IND_TYPE

This is used to specify the industry type for CHASE pay-
ment interface for Credit Cards. Input parameter value is
user defined.

CRD_CHS_MER-

This captures the merchant ID number for CHASE pay-

CHANT _ID ment interface for Credit Cards. Input parameter value is
user defined.
CRD_CHS_RE- This captures the remote host name for seeking approvals

MOTE_HOST_NAME

for CHASE payment interface. Input parameter value is
user defined.

CRD_CHS_SEC_RE-
MOTE_HOST_NAME

Similar to the previous parameter this captures the sec-
ondary remote host name of CHASE interface for seeking
approvals for credit card payments. Input parameter value
is user defined.

CRD_CHS_TIMEOUT

This parameter is used to define the timeout limit when
polling the interface for processing credit card payments.
Input parameter value is numeric.
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Parameter

Description

CRD_CHS_USR_ID

This parameter captures the user id for CHASE interface
which is required whenever the System needs to access/
seek authorizations/process payments for credit cards etc.
Input parameter value is user defined.

CRD_PTB_RE-
MOTE_HOST_NAME

This is the Protobase Remote Host Name

CRD_PTB_RE-
MOTE_HOST_PORT

This is the Protobase Remote Host Port

CRD_PTB_TIMEOUT

This is the Protobase Timeout Value

CRD_SOURCE_TYPE_CD

This is the Source Type Code

DDT_CREATE_DUE_-
DATE_HISTORY

This parameter must be enabled to create a due date his-
tory for any account. Due date history sub tab under Trans-
action history displays the delinquency history of an
account in a tabular format detailing Due date, Due
Amount, Last Payment date, Payment Amount, Balance
Amount, Days past due and Payment received flag. The
input parameter value for this parameter is Boolean (Yes/
No).

DECI-
SION_BUY_RATE_TOL-
ERANCE

This parameter is used to define the variance in buy rate

EDF_DIALER_ACCT -
TYPE

This parameter is used to set up the account number refer-
ence for the dialer file to pick-up records for Auto dialer
interface. Input parameter value is account number.

FLL_BPEL_PROCESS

This parameter is set to use BPEL process in OFSLL.
Input parameter value is Boolean (Yes/No).

ICA_INPUT_FILE_FOR-
MAT

This parameter is used to define the input call activity file
format

IFD_DIRECTORY

This parameter is used to define the Oracle directory
object name for IFD file location

IFD_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle directory
object name for IFD file location

INCOM-
ING_LOB_PURGE_DAYS

This parameter is used to define the incoming process file
table purge days

INPUT_DIRECTORY

This parameter is used to define the Oracle directory
object name for INPUT file location

ITU_DIRECTORY

This parameter is used to define the Oracle directory
object name for ITU file location

ITU_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle directory
object name for ITU file location

IVR_DIRECTORY

This parameter is used to define the Oracle directory
object name for IVR file location
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Parameter

Description

IVR_PROCESSED_DI-

This parameter is used to define the Oracle directory

RECTORY object name for IVR file location

JSC_TIMEOUT This parameter is used to set the polling interval for job
scheduler. Input parameter value is numeric. To check
whether it represents minutes/seconds.

JSV_ARCHIVE_- This parameter is used to set the configuration file for

SERVER_CONFIG

reports archive server. Input parameter value is user
defined.

JSV_ARCHIVE_-
SERVER_URL

This parameter is used to specify the archive server url.
Input parameter value is user defined.

JSV_BI_PASSWORD

This parameter is used to define the Bl Publisher Pass-
word

JSV_BI_USER

This parameter is used to define the Bl Publisher User ID

JSV_TEMPORARY_DI-
RECTORY

This parameter is used to define Oracle directory object
name for Job Service Temp file location

JSV_BI_PASSWORD-
JSV_REPORTS_RUNT-
IME

This parameter is to specify the reports runtime program.
Input parameter value is user defined.

JSV_REPORTS_RUNT-
IME_CMDFILE

This parameter is used to specify the reports runtime com-
mand file. Input parameter value is user defined.

JSV_REPORTS_-
SERVER_CONFIG

This parameter is used to specify the configuration file for
reports server. Input parameter value is user defined.

JSV_REPORTS -
SERVER_URL

This is used to specify the URL for the reports server. Input
parameter value is user defined.

JSV_REPORT_AR-
CHIVE_DIRECTORY

This is used to specify the path and directory of Reports
archive, input parameter value being numeric.

JSV_SMTP_SERVER

This parameter specifies the SMTP server used by job ser-
vice for sending email messages. Input parameter value is
user defined.

JSV_TIMEOUT

This is to specify the polling interval for the job service dur-
ing time out. Input parameter value is numeric. To check
whether it represents minutes/seconds.

JSV_USE_BI_PUBLISHER

This parameter defines whether Bl publisher should be
used to process reports are not. Input parameter value is
Boolean (Yes/No).

JSV_USE_REPORTS_-
SERVER

This parameter is used to specify whether reports server
from job service should be used or not. Input parameter
value is Boolean (Yes/No).

LBX_TXN_GROUP-
ING_CNT

This parameter is used to specify the no. of records per
batch for payment transactions and lock box batch
records. Input parameter value is numeric.
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Parameter

Description

LCO_COL_LET-
TER1_GEN_DAYS

This parameter specifies the number of days post which
first collection letter should be generated for accounts with
dues unpaid. Input parameter value is numeric.

LCO_COL_LET-
TER2_GEN_DAYS

This parameter specifies the number of days post which
second collection letter should be generated for accounts
with dues unpaid. Input parameter value is numeric.

LCO_COL_LET-
TER3_GEN_DAYS

This parameter specifies the number of days post which
third collection letter should be generated for accounts with
dues unpaid. Input parameter value is numeric.

LIEN_RELEASE_DAYS

This parameter is used to define the Lien Release Days

LOCKBOX_DIRECTORY

This parameter is used to define the Oracle directory
object name for Lockbox file location

LOCKBOX_PRO-
CESSED_DIRECTORY

This parameter is used to define the Oracle directory
object name for processed Lockbox file location

LOR_ADVERSE_AC-
TION_GEN_DAYS

This parameter is used to specify the number of days after
the third collection letter post which the adverse action let-
ter is to be generated. Input parameter value is numeric.

LOG_LOB_PURGE_DAYS

This parameter is used to log files header table purge days

MAX_AGED_TXN_AU-
THORIZE_DAYS

This parameter is used to specify the maximum number of
days within which a transaction should be authorized. Input
parameter value is numeric and represents the number of
days.

MAX_VOID_TXN_AU-
THORIZE_DAYS

This parameter is used to set the maximum days to author-
ize transaction

OCP_CUSTOMER_P-
MT_SITE_ID

This parameter is used to set the customer payment
extract file site id

OCP_IN-
CLUDE_ACH_ACC

This parameter is used to set the customer payment
extract including ach accounts

OUTGO-
ING_LOB_PURGE_DAYS

This parameter is used to define the outgoing process file
table purge days

OUTPUT_DIRECTORY

This parameter is used to define Oracle directory object
name for OUTPUT file location

PAC_ARCHIVE_DAYS

This parameter is used to define number of days for peri-
odic archiving of account. Input parameter value is
numeric.

PAC_OARCHIVE_DAYS

This parameter is used to define the number of days for
archiving accounts from ‘O’ tables i.e. old tables. Input
parameter value is numeric

PAP_ARCHIVE_DAYS

This parameter is used to define the number of days for
archiving applications on a periodic basis. Input parameter
value is numeric.
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PAP_OARCHIVE_DAYS

This parameter is used to define the number of days for
archiving applications from ‘O’ tables. Input parameter
value is numeric.

PCU_CHECK_REFUND_-
DAYS

This parameter is used to specify the maximum number of
days within which an overpayment from the customer can
be refunded. Input parameter value is numeric.

PDC_PRE_PROCESS_-
DAYS

This parameter value will define the number of days prior
to the due day, regular account PDC process should be ini-
tiated. Input parameter value is numeric.

PENDING_PDC_DAYS

This parameter value will define the number of days before
the initiation day for pending PDC accounts.

PGL_ARCHIVE_DAYS

This parameter defines the number of days, post which the
transactions in GL would be archived. Input parameter
value is numeric

PGL_OARCHIVE_DAYS

This parameter is used to define the number of days, post
which the transactions in GL will be moved to the ‘O’
tables. Input parameter value is numeric.

PJR_PURGE_DAYS

This parameter is used to specify the days post which the
job requests are to be purged. Input parameter value is
numeric.

POD_PURGE_DAYS

This parameter is used to define the number of days after
which the Output data file headers are to be purged. Input
parameter value is numeric.

PPA_ARCHIVE_DAYS

This parameter is used to specify number of days after
which pools and its transactions archiving is to be done to
‘O’ tables. Input parameter value is numeric.

PPA_OARCHIVE_DAYS

This parameter is used to specify number of days after
which pools and its transactions archiving is to be done to
‘O0’ tables. Input parameter value is numeric

PPR_ARCHIVE_DAYS

This is used to specify the days for archival of producers
details on a regular basis. Input parameter value is
numeric.

PPR_OARCHIVE_DAYS

This is used to specify the days after which the producers
details from ‘O’ tables need to be archived. Input parame-
ter value is numeric.

PPX_ARCHIVE_DAYS

This is used to specify the days after which producer trans-
actions are to be archived. Input parameter value is
numeric.

PPX_OARCHIVE_DAYS

This is used to specify the days after which the producer
transactions are to be moved from ‘O’ tables. Input param-
eter value is numeric.

PJR_COPY_PURGED _-
DATA

This parameter is used to copy data into purge tables
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PST_ARCHIVE_DAYS This parameter specifies the number of days for which the
statements are to be archived. Input parameter value is
numeric.

PST_OARCHIVE_DAYS This parameter specifies the number of days for which the
statements are to be archived in the ‘O’ tables. Input
parameter value is numeric.

PTT_PURGE_DAYS This is used to specify the number of days after which the
PTT table is to be purged. Input parameter value is
numeric.

PTX_ARCHIVE_DAYS This parameter is used to specify the number of days the
transactions are to be archived. Input parameter value is
numeric.

PTX_OARCHIVE_DAYS This parameter is used to specify the number of days after
which the archived transactions from ‘O’ tables are to be
moved. Input parameter value is numeric.

PUL_PURGE_DAYS This parameter is used to specify the number of days post
which the User login details are to be purged. Input param-
eter value is numeric.

PVA_ARCHIVE_DAYS This parameter stores the number of days for archival of
regular vendor assignments. Input parameter value is
numeric.

PUP_ARCHIVE_DAYS This parameter stores the number of days for archival of

transaction upload. Input parameter value is numeric

PUP_OARCHIVE_DAYS This parameter is used to specify the number of days after
which the archived transactions from ‘O’ tables are to be
moved. Input parameter value is numeric

PVA_OARCHIVE_DAYS This parameter value specifies the number of days for
archival of vendor assignments from ‘O’ tables to ‘OO’
tables. Input parameter value is numeric.

PVI_ARCHIVE_DAYS This parameter is used to specify the number of days for
which the regular vendor invoices are to be archived. Input
parameter value is numeric.

PVI_OARCHIVE_DAYS This parameter is used to specify the number of days post
which the regular vendor invoices are to be moved from ‘O’
tables to ‘OQ’ tables. Input parameter value is numeric.

RAC_LOAD_FREQUENCY | This parameter is used to specify Accounts RDH Load Fre-
quency

RAP_LOAD_FREQUENCY | This parameter is used to specify Applications RDH Load
Frequency

RAT_LOAD_FREQUENCY | This parameter is used to specify Asset Tracking RDH
Load Frequency
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Description

RBK_LOAD_FREQUENCY

This parameter is used to specify Bankruptcy Details RDH
Load Frequency

RCA_LOAD_FREQUENCY

This parameter is used to specify Call Activities RDH Load
Frequency

RCH_LOAD_FRE-
QUENCY

This parameter is used to specify Deficiency Details RDH
Load Frequency

RCO_LOAD_FRE-
QUENCY

This parameter is used to specify Contracts RDH Load
Frequency

RFO_LOAD_FREQUENCY

This parameter is used to specify Repo-Foreclosure RDH
Load Frequency

RPR_LOAD_FREQUENCY

This parameter is used to specify Producers Rdh Load
Frequency

RST_LOAD_FREQUENCY

This parameter is used to specify Setup Data RDH Load
Frequency

RTX_LOAD_FREQUENCY

This parameter is used to specify Txns RDH Load Fre-
quency

SALESAGENT -
MAIL_SEND_IND

This parameter is used to specify whether decision fax
needs to be sent to sales agent (yes/no)

SCORING_PARAME-
TER_ALERT

This parameter is used to set the scoring parameter alert

SQL_DIRECTORY

This parameter is used to set the Oracle directory object
name for SQL file location

TES_ANA_PRE_PROCES
S_CYCLES

This parameter is used to specify the pre-process cycles
required for Escrow analysis. Input parameter value is
numeric.

TES_DSB_ANALY-
SIS_PERCENT

This parameter is used to specify the percentage for
escrow disbursements. Input parameter value is numeric.

TES_DS-
B_PRE_PROCESS_DAYS

This is used to specify the number of days for pre-process
for escrow disbursements. Input parameter value is
numeric.

TPE_AMORTIZE_AC-
CRUED_INT_ONLY

This parameter is used to specify that system has to amor-
tize accrued interest at month end

TPE_APPLY_LTC -
FROM_CURR_DUE_DT

This parameter is used for pyramid law fee method to
apply late charge from current due date

TPE_ESC_ANALY-
SIS_DELQ_AMT

Parameter considers billed but uncollected amount for
escrow analysis

TPE_EXCESS_PAY-
MENT_TO_MEMO

Excess payment on the account will be moved to memo
payment.
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Description

TPE_EXCLUDE_ESC_LTC

This parameter defines whether escrow should be included
or excluded while calculating late charge. Input parameter
value is Boolean (Yes/No).

TPE_EXT_CY-
CLES_BACKDATED

This parameter is used to define the maximum extension
cycles allowed for back dating. Input parameter value is
numeric with no upper limit

TPE_FUTURE_PAYOFF _-
DAYS

The value specified in this parameter validates the ‘Valid
Up to Date’ with ‘Payoff quote’ during monetary transac-
tions posting.

TPE_GL_RE-
FUND_HOLD_DAYS

This parameter is used to define the number of days the
non-refunded amount can be held in GL. Input parameter
value is numeric.

TPE_MAX_CY-
CLES_BACKDATED

This parameter is used to define the maximum cycles that
are allowed for back dating in OFSLL. Input parameter
value is numeric.

TPE_MIN_1098_INT_AMT
_PAID

This parameter is used to specify the lower limit or mini-
mum interest amount paid for 1098 i.e. Mortgage Interest
Statement. In the US, Fls need to report mortgage interest
of $600 or more received from individuals, during the
course of their business. Input parameter value is 600, the
minimum value above which reporting by Fl is required in
form 1098 for each mortgage account.

TPE_OLDEST -
DUE_DT_NEW_MTHD

This parameter is enabled to specify whether new method
for calculation of oldest due date based on given data
should be used or not. Input parameter value is Boolean
(Yes/No).

TPE_PAID_TO_CLOSE._-
DAYS

This parameter is used to specify the number of days
allowed post which a paid account would be closed. Input
parameter value is numeric.

TPE_PAYMENT_TO_-
MULTI_ACCOUNTS

This parameter is enabled to allow one payment for dues in
multiple accounts. Input parameter value is Boolean (Yes/
No).

TPE_PAYOFF_VAL-
ID_THRU_DAYS

This parameter is used to specify the number days the
pay-off quote is valid by default. i.e. if the parameter is set
as 7, the payoff quote is valid for 7 days and customer can
pay the quoted amount as final closure amount within
those days. Input parameter value is numeric.

TPE_PMT_POST_EOD

This parameter is used to allow payments when the batch
process for End of Day is running. Input parameter value is
Boolean (Yes/No). If this is set to “Y’, payments can be
allowed during EOD.

TPE_SCHGOFF_DLQ_-
DAYS

This parameter is used to define the number of delinquent
days to treat an account for SCHGOFF (charge — off).
Input parameter value is numeric. (To verify)
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TPE_SCHGOFF_RE-
VIEW_DAYS

This parameter is used to define the number of days
allowed for review of SCHGOFF accounts. Input parame-
ter value is numeric.

TPE_SCRA_DEFAULT_IN-
TEREST_RATE

This parameter is used to define the default interest rate
that is to be applied for customers who are in military duty.
OFSLL will apply the lower of the prevailing interest rate or
SCRA default interest rate specified through this parame-
ter. Input parameter value is numeric (in this case 6, which
is interest rate to be applied for SCRA accounts.

TPE_SHOW_BACK-
DATE_WARNING

This parameter is used to define whether a warning mes-
sage is to be shown if monetary transaction is backdated

TPE_ST-
M_INC_ALL_TXNS

This parameter is enabled to define whether all transac-
tions should be included in the statements or otherwise.
Input parameter value is Boolean (Yes/No).

TPE_STOP_COMP_DELQ
_DAYS

This parameter is used to stop computation when delq
days > 60

TPE_TXN_POST_DE-
FAULT _GLDATE

This parameter is used to default GL date in date type
parameters during txn posting (y/n)

TPE_VOID_TO_CLOSE .-
DAYS

This parameter is used to define the number of days
allowed for closing Void accounts. Input parameter value is
numeric.

UIX_DEFAULT_IMAGE._-
PATH

This parameter is used to define the default image direc-
tory maintained for the purpose of online attachment of
document images to an application using documents main-
tenance section under Account documentation. Input
parameter value is user defined.

UIX_DIRECT_LOAN_-
COMBO_ULN_UFN

This parameter when set to yes allows underwriting and
funding to be carried on by a single responsibility for direct
loans only. Input parameter value is Boolean (Yes/No).

UIX_INCOMING_FILE_-
PATH

This parameter is used to specify incoming file path of app
server

UIX_LOCAL_COUN-

Through this parameter we can set the local country where

TRY_CD an Fl has multiple branches across different geographies.
Input parameter value is user defined.
UIX_LOCK_UN- This parameter is used to enable the user interface lock /

LOCK_AND_COPY

unlock and copy features. Input parameter value is
Boolean (Yes/No).

UIX_MAX_ACC._-
SEARCH_ROWS

This parameter is used to specify the maximum number of
account rows to be returned for search functionality. Input
parameter value is numeric.

UIX_MAX_APP_-
SEARCH_ROWS

This parameter is used to specify the maximum number of
application rows to be returned for search functionality.
Input parameter value is numeric.
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UIX_OUTGOING_FILE_-
PATH

This parameter is used to specify outgoing file path of app
server

UIX_REPORTS -
SERVER_CONFIG

This parameter can be used to specify the user interface
reports server configuration file. This is not required for
OFSLL.

UIX_REPORTS -
SERVER_URL

This parameter sets the URL for Reports server. Input
parameter value is user defined.

UIX_SHOW_LN_VARIA-
BLE_RATE_TABS

This parameter can be used to show loan variable rate
tabs. Input parameter value is Boolean (Yes/No). This is
not required for OFSLL.

UIX_UTILITIES_SERV-
LET_URL

This parameter can be used to specify the User Interface
utilities servlets URL. This is not required for OFSLL.

UPR_PRO_NBR_SYS-
_GENERATED

This parameter can be used to specify whether producer
number should be system generated or seek input from
user. Input parameter value is Boolean (Yes/No). Generally
this is set to yes for system generation.

VEV_NADA_TOKEN_URL

This parameter is used to set the token URL for vehicle
evaluation interface NADA. Input parameter value is user
defined.

VEV_NADA_UPDATE_-
DAY

This parameter is used to specify the day of the month to
update the vehicle evaluations every month. Input parame-
ter value is numeric.

VEV_NADA_URL

This parameter is used to set the URL for vehicle evalua-
tion interface NADA. Input parameter value is user defined.

VEV_NADA_USER_ID

This parameter is used to specify the User id for login to
the NADA interface. Input parameter value is user defined.

VEV_NADA_USER_PASS-
WORD

This parameter is used to specify the password for login to
the NADA interface. Input parameter value is user defined.

VEV_VALUATION_RE-
GION

This parameter is used to define the default region for vehi-
cle evaluation. Input parameter value is the region name,
and is user defined.
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VEV_VALUATION_-
SOURCE_CD

This parameter is used to specify the default vehicle evalu-
ation source code. Input parameter value is user defined. A
number of parameters are possible in OFSLL as below:
1.Appraisal Company

2.Broker

3.BUC GUIDE

4.DATA QUICK

5.NAMS/SAMS SURVEY - USED

6.REALTOR

7.NADA INTERFACE USED CARS

8.BLACKBOOK INTERFACE USED CARS

9.KELLY INTERFACE

10.NADA — NEW

11.NADA — USED

12.KELLY NEW BLUE BOOK

13.KELLY USED BLUE BOOK

14.INVOICE

15.BLACK BOOK

16.NADA INTERFACE COMMERCIAL TRUCKS
17.COMPANY INVOICE

18.GOLD BOOK

19.GALVS

20.0THER

21.ALG

WFP_DIRECTORY

This parameter is used to specify the Oracle directory
object name for WFP file location

WFP_MAX_CY-
CLES_BACKDT

This parameter is used to specify the back dated cycles
date for WFP.

WFP_PROCESSED_DI-
RECTORY

This parameter is used to define oracle directory object
name for wfp file location.

WFP_REVERSE_TX-
N_IND

This parameter is enabled to define the WFP reversal indi-
cator. Input parameter value is Boolean (Yes/No).

XAE_DEALUPD_MAX_AL-
LOWED_DAYS

This parameter is used to define the max allowed days for
Deal Update

XAE_DEALUPD_AL-
LOWED_IND

This parameter is used to indicate whether deal update is
allowed or not

OUTBOUND_CALL_Q

This parameter is used to generate reports (including
emailing statements/letters) using Application Server
instead of Database server.

ACA_PRE_PROCESS_-
DAYS_FIRST

This parameter is used to configure the number of days
before the debit day for ACH process in first time/ one-time
case

IPR_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle directory
object name for processed IPR file location

IPR_DIRECTORY

This parameter is used to define the Oracle directory
object name for IPR file location
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UIX_PWD_MGMT_EX-
TERNAL_URL

This parameter is used to set external password manage-
ment url, if applicable

UIX_PWD_MGMT_EX-
TERNAL

This parameter is used to define the parameter if password
management is external. (SET Y IF PASSWORD MAN-
AGEMENT IS EXTERNAL (Y/N)).

ICU_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle directory
object name for processed ICU file location

ICU_DIRECTORY

This parameter is used to define the Oracle directory
object name for ICU file location

UIX_BILL_CYCLE_AL-
LOWED_IND

This parameter is used to indicate whether Billing cycle is
allowed at the application level

CMN_EOD_SLEEP_MINS

This parameter is used to set in minutes the EOD sleep
time

CMN_CORE_BANK_TX-
N_CD

This parameter is used to set code for OFSLL and Core
Banking integration

UIX_DIRECT_DISB_MAN-
UAL_SELECT

This parameter will allow manual selection of disbursement
mode for direct loans

ICC_DLQ_AMT_EX-
CLUDED

This parameter enabling will exclude delinquency amount
for CASA account

CMN_CORE_BANK_IND

This parameter is used to set whether OFSLL can inte-
grate with Core Banking.

BKRP_FILE_REC_LIMIT

This parameter is used to set the limit of total number of
records allowed to be added in the ‘Input Data File’ shared
from external interface.

Note: if the number of records exceeds the set limit, multi-
ple ‘Input Data Files’ are to be created.

UVN_VEN_NBR_SYS-
_GENERATED

This parameter is used to validate if ‘Vendor Number’ has
to be auto generated (if set to Y) or to be specified manu-
ally in the Vendor details screen.

METRO_WITHOUT _COL-
L_IND

This parameter indicates whether Metro Il reporting is han-
dled without OFSLL Collections module being used. If the
parameter value is set as ‘Y’ i.e. collection module is not
used, system updates the collateral status directly as part
of ‘REPQO’ call activity.

However when Collections module is being used, the Col-
lateral status is tracked with the repossession details
updated in 'Repo/Foreclosure' screen of Collections mod-
ule.
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METROII_-
FIRST_DELQ_DT_ADD -
DAY

This parameter is used to calculate the first delinquency
date that needs to be reported in the Metro Il reporting file.

By default the parameter is 'disabled' indicating that the ini-
tial delinquency date calculated by the system is used for
Metro Il reporting. The same needs to be enabled to add
the parametrized number of days to the system calculated
first delinquency date for the Metro Il reporting purpose.

DAYS_TO_PULL_CR-
B_REPORT

This parameter is used to configure the number of days
permitted to pull a Bureau report from the same company
and for the same customer.

XWS_ACS_RESP_-
MULTI_RECORD_IND

This parameter is used to indicate if multiple records exist
in the response file received for account search.

Accordingly, when there are multiple records found and
this parameter is enabled and set to ‘No’ (default), system
displays an error message “Too Many Records Found.
Please Refine Search by Adding One More Parameter”

However, when this parameter is set to ‘Yes’, system only
indicates that there are multiple records/rows in response
file.

GRI_DLQ_DAYS_AU-
TO_STATUS_CHG

This parameter is used to define the delinquency days
which inturn is used to automatically update the status of a
work order to ‘PENDING ON HOLD’ status.

TPE_PMT_POSTING_-
CLS_ACCOUNT

This parameter is used to define the payment posting crite-
ria for Closed - Paid Off/ Charged-off accounts.

Accordingly, OFSLL accepts payment posting on closed
accounts only when the parameter is set to ‘Y’ and all the
payments received through Payment Entry screen or ‘Pay-
ment Upload’ file are posted to a ‘Suspense’ account.

TPE_BACKDT_P-
MT_POSTING

This parameter is used to define the payment posting crite-
ria for backdated payments for the following type of
account conditions:

- Paid off

- Charged-off

- Account under activation

- Account under conversion

- Non-performing Account

- PC2 SI (Pre-computed to Simple Interest) Reschedule

Accordingly, OFSLL accepts backdated payment posting
only when the parameter is set to ‘Y’ and all the payments
received through Payment Entry screen or ‘Payment
Upload’ file are posted to a ‘Suspense’ account.
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EXP_PA_-
SOFT_PULL_IND

This parameter when enabled allows ‘Soft Pull’ Credit
Bureau request, specifically for Experian Premier Attribute
Consumer Report without impacting the consumer FICO
score.

PMT_BATCH_POSTING

This parameter (PAYMENT BATCH POSTING PREFER-
ENCE) is used to define the status of payment transactions
which are uploaded in bulk through a batch process.

POOL_ACTIVE_AC-
COUNTS_ONLY

This parameter controls the type of accounts that can be
added to a Securitization Pool and allows adding only
‘Active’ status accounts since the same is enabled (value
set to Y’) by default. To add accounts with other status
such as Active, Paid Off, Charged Off, Void, Terminate.
and so on, set the value of system parameter to ‘N’.

AUTO_GEN_ACC_NBR -
CONV

This parameter is used for conversion accounts to decide
option of account number generation. If the value of
parameter is set to Y’ the account number is automatically
generated in OFSLL during conversion and if the value is
‘N’, then external reference number (generated in third
party system) itself is appended as the account number.

OUTBOUND_DL-
R_TRACK_Q

This parameter defines the settings for batch job
‘SET_XPR’ to either use MDB (Message Driven Bean) flow
(if value set to ‘Y’) or existing work flow (if value set to ‘N’)
to dump producer details maintained in the system into
Dealer Track.

MDB flow generates outbound JMS message though the
configured MDB interface and can avoid current database
outbound calls and session timeout.

In the existing workflow, the database makes synchronous
outbound calls to producer data dump web service, to
dump the data and acknowledge the database with the sta-
tus (success or failure).

OUTBOUND_ROUTE-
ONE_Q

This parameter defines the settings for batch job
‘SET_XPR'’ to either use MDB (Message Driven Bean) flow
(if value set to ‘Y’) or existing work flow (if value set to ‘N’)
to dump producer details maintained in the system into
ROUTEONE.

MDB flow generates outbound JMS message though the
configured MDB interface and can avoid current database
outbound calls and session timeout.

In the existing workflow, the database makes synchronous
outbound calls to producer data dump web service, to
dump the data and acknowledge the database with the sta-
tus (success or failure).
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GRI_WEBSER-
VICE_LOG_IND

This parameter is used to decide on logging GRI (Generic
Recovery Interface) communications. If enabled, system
logs all the GRI related web service communications
between OFSLL and external interfaced system.

The recorded logs can be viewed in Dashboard > System
Monitor > Database Server Log Files tab by selecting
‘Interfaces’ view option.

PVE_ARCHIVE_DAYS

This parameter stores the number of days for archival of
regular vendors. Input parameter value is humeric.

PVE_OARCHIVE_DAYS

This parameter is used to specify the number of days post
which the regular vendors are to be moved from ‘O’ tables
to ‘OO0’ tables. Input parameter value is numeric.

LBX_DR_CR_VALI-
DATE_AMT_IND

This parameter (VALIDATE LOCKBOX DR/CR BATCH
TOTALS) is used to facilitate NACHA file validation. Based
on the status of the parameter, system is either allowed to
validate the file or process without validation.

PAP_PURGE_DAYS

This parameter allows to define the number of days after
which the application data from archival folders are to be
deleted permanently. Purging happens based on elapsed
number of days i.e. if value is set to 60 days, only those
records which are older by 60 days in archival folder are
deleted.

PAC_PURGE_DAYS

This parameter allows to define the number of days after
which the accounts data from archival folders are to be
deleted permanently. Purging happens based on elapsed
number of days i.e. if value is set to 60 days, only those
records which are older by 60 days in archival folder are
deleted.

CMN_SED -
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing seed data is to be processed. If
set to Y’, system processes the data to/from LOB and if
set to ‘N’, system processes the data to/from FILE.

CMN_EDF_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing data from Dialer Interface is to be
processed. If set to Y’, system processes the data to/from
LOB and if set to ‘N’, system processes the data to/from
FILE.

The same is used by the batch jobs EDFADR_BJ_100_01
and EDFIVR_BJ_100_01 which are available in SET-EDF
Batch Job Set.

CMN_FAX_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing Fax data is to be processed. If set
to Y’, system processes the data to/from LOB and if set to
‘N’, system processes the data to/from FILE.
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CMN_RED _-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the outgoing details of Data Masking Policy (i.e. Redaction
policy output file) is to be processed. If set to Y’, system
processes the data from LOB and if set to ‘N’, system pro-
cesses the data from FILE.

The same is used by the batch job REDPRC_BJ_100_01
available in SET-RED Batch Job Set.

CMN_WFP_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing WFP Unit details are to be pro-
cessed. If set to Y’, system processes the data to/from
LOB and if set to ‘N’, system processes the data to/from
FILE.

The same is used by the batch job WUPPRC_BJ_132_01
available in SET-WFP Batch Job Set.

CMN_AUD_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the outgoing Audit scripts are to be processed. If set to Y’,
system processes the data from LOB and if set to ‘N’, sys-
tem processes the data from FILE.

CMN_LBT -
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing Lockbox files are to be pro-
cessed. If set to Y’, system processes the data to/from
LOB and if set to ‘N’, system processes the data to/from
FILE.

The same is used by the batch jobs LBXPRC_BJ_100_01
and LBXSEP_BJ_100_01 available in SET-LBT Batch Job
Set.

CMN_ODD_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the outgoing ODD or Output Data Dump files are to be pro-
cessed. If set to Y’, system processes the data from LOB
and if set to ‘N’, system processes the data from FILE.

The same is used by the batch job ODDPRC_BJ_000_01
available in SET-ODD3 Batch Job Set.

CMN_ALERT_DE-
BUG_METHOD

This parameter allows to define the location to which Alert
and Warning logs are to be written. If set to ‘ADVANCE_-

QUEUE’, system writes the logs in Logs table and if set to
‘UTL_FILE’, system generates the alert log file.

CMN_GRI_WS_DE-
BUG_METHOD

This parameter allows to define the location to which GRI
(Generic Recovery Interface) web service logs are to be
written. If set to ‘ADVANCE_QUEUE’, system writes the
logs in Logs table and if set to ‘UTL_FILE’, system gener-
ates the log file.
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UIX_CUSTOM-
ER_BASED_PMT_IND

If this parameter is set to ‘Y’ and is ‘Enabled’, system
accepts posting direct payment to an account and also
accepts customer based payments to all linked accounts.

To facilitate customer based payments, ‘Customer/Busi-
ness # and ‘Payment Hierarchy’ fields along with ‘Popu-
late Accounts’ button are enabled in ‘Payment Entry’
screen to specify required values.

PMT_HIERARCHY_CODE

In this parameter, you can specify a payment hierarchy
which is populated by default in Customer Details and
Business Details (if applicable) screen after account acti-
vation.

However, the specified value is selected by default only if
there is a matching hierarchy definition enabled record
maintained in Setup > Administration > User > Payment
Hierarchy screen. Else, ‘Equal Amount’ value is selected
which in-turn adjusts the payment equally to all customer/
business linked accounts.

Note: System does not consider this parameter value
while ‘creating account using existing customer/business
details’ since the default selection is done during the crea-
tion of existing customer / business account.

EVI_MAX_RE-
TRY_COUNT

This parameter records and controls the maximum
attempts to re-trigger FAILED Webhook requests which
cannot exceed more than 5 times. However, this parame-
ter can be modified if the maximum re-trigger attempts is to
be less than 5 times.

UIX_CUSTOM_LA-
BEL_ENABLED_IND

This parameter indicates if the field label customizations
are allowed i.e. ability to change label and provide access
to fields in Label Configuration and Security User Access
Definition Details screens.

If set to “Y’, system refers data from database

If set to ‘N’, system refers data from XLIB file.

UIX_MASTER_AC-
C_BASED_PMT_IND

If this parameter is set to ‘Y’ and is ‘Enabled’, system
accepts posting direct payment to a master account and
also accepts master account based payments to all linked
accounts.

To facilitate master account based payments, ‘Master
Account # field is enabled in ‘Payment Entry’ screen.

TPE_PMT_RE-
FUND_CURRENCY_S-
RC_CD

This parameter indicates the currency in which payment
refund has to be processed in the system as either ‘Pay-
ment Currency’ or ‘Account Currency’. The same is consid-
ered during payment refund operation in Payment
Maintenance screen.
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Parameter

Description

AUTO_GEN_ACTIVE_TX-
N_CONV

This parameter if enabled, auto posts a dummy ACTIVE
transaction on all ‘migrated accounts’ during the schedule
batch job run. This in-turn allows to post RESCISSION /
VOID transaction specifically for migrated accounts by
selecting the dummy transaction from Customer Service >
Maintenance screen or Transaction History transactions
tab,

For more information, refer ‘Voiding an Account’ section
Servicing user guides.

FLL_CMN_JET_JWT_EN-
ABLED_IND

(JET JWT TOKEN ENA-
BLE INDICATOR)

This parameter if set to 'Y’, enables the ‘Account Dash-
board’ screen in Servicing LHS menu. This screen is
based on Oracle JET framework and facilitates to view
Account summary details maintained in the system. For
information on screen functionality, refer to Servicing User
Manuals and for details on deployment and configuration,
refer to Installation Manuals.

FLL_CMN_JET JWT_TO-
KEN_URL

(JET JWT TOKEN GENER-
ATION URL)

Define the value of the O-JET URL (app-shell application
URL) in the format https://<hostname>:<port no>/ofsll-app-
shell/<token>

FLL_SER_JET_AC-
C_CREATE_URL

(JET SIMPLE ACCOUNT
CREATE URL)

Define the value of the O-JET URL (app-shell application
URL) in the format https://<hosthame>:<port no>/ofsll-app-
shell?root=accountonboarding

FLL_SER_JET_ACC_-
DASHBOARD_URL

(JET ACCOUNT DASH-
BOARD URL)

Define the value of the O-JET URL (app-shell application
URL) in the format https://<hosthame>:<port no>/ofsll-app-
shell?root=accountdetailsdashboard

FLL_SET_JET_INTELLI-
GENTSEG_URL

(JET INTELLIGENT SEG-
MENTATION URL)

Define the value of the O-JET URL (app-shell application
URL) in the format https://<hostname>:<port no>/ofsll-app-
shell?root=queuecreation

ACCOUNT_PROCESS-
ING_THRESHOLD

(ACCOUNT ON-BOARD-
ING ASYNCHRONOUS
PROCESSING THRESH-
OLD)

This parameter allows to restrict the number of accounts
that can be created ‘synchronously’ using Account on-
boarding WebService.

However, creating accounts asynchronously in the system
is further processed by the below batch jobs based on val-
ued defined in this parameter.

SET-API2 (ASYNCHRONOUS ACCOUNT CREATION)
-- ACXVAL_BJ_100_01 (VALIDATE IAPP TABS)

-- ACXAAI_BJ_100_01 (ASYNCHRONOUS ACCOUNT
CREATION)
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C.3

Organization Parameters

Organization parameters control the functions related to User login, password expirations,
responsibilities and accessibility limits in the OFSLL system. Individual parameters can be
created with different values for uniquely defined organizations, divisions, and responsibility
combinations.

There are three more dimensions other than parameter name, description and enabling
(similar to system parameters) as indicated below:

1. Organization

2. Division

3. Responsibility

These dimensions help to define the applicability of the responsibility for specific User in an
Organization across selected Divisions/departments.

When determining which parameter to use, OFSLL system selects the best match based on
a hierarchical sort by the Organization, Division, and Responsibility fields, with values of 'ALL'
being a lower order match than an exact match.

While the system allows for Organization parameters to be defined at all three hierarchical
levels (organization, division, and responsibility), not all will be applicable to each parameter.

Parameter Description

MAX_PASSWORD_HISTO- | This is used to set limit for number of times a password
RY_CHECK has been repeated during password change. This can be
set for specific branches of the Organization, Divisions and
Users based on responsibilities. Numeric value to be input
to specify the limit.

UCS_GROUP_FOL- This parameter is used to set up the number of days range
LOWUP_DAYS for Group follow-up field in customer service screen which
displays the set of accounts that share same account con-
dition as the selected account and bear the same cus-
tomer ID. The pre-requisite for this is Group Follow-up
indicator should be enabled in queue setup. Input value is

numeric.
UCS_REVIEW _- This is used to specify whether review can be done by the
QUEUE_ALLOWED specific responsibility (user group) without entering details

in call activities/activities. Parameter value to be input is
Boolean (Yes/No).

UIX_AP- The system uses this parameter to determine which users
P_VIEW_ALL_APPS have the ability to view all applications. The system selects
the best match based on a hierarchical sort by Organiza-
tion, Division and Responsibility fields, with values of ‘ALL’
being a lower order match than an exact match. Input
parameter value is Boolean (Yes/No).
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Parameter

Description

UIX_HIDE_RESTRICT-
ED_DATA

This is used to hide sensitive data relating to the Contract /
Applicant to a specific group/responsibility etc. Suppose
there is a need to hide data relating to SSN, Bank account
details etc. to a specific user responsibility who will not
need such data, this parameter can be enabled with input
value Boolean (Yes/No). If this parameter is set to Y’, the
details appear in a masked format (for e.g. SSN — XXX-
XX-456)

UIX_SMTP_SERVER

This parameter is used to set up the email server for user
interface. The input value would be ‘SETME’ and check
the ‘Enable’ flag.

UIX_VIEW_SE-
CURED_ACCOUNTS

This is used to specify whether an account can be viewed
by a specific responsibility (users). Parameter value is
Boolean (Yes/No) and when flagged as Yes, such
accounts would be viewable only by users defined in the
Organization, Division hierarchy with the specified respon-
sibilities. For example, all employee accounts may not be
viewable by all users and should be made available only to
the HR department with specific responsibility levels.
Note: While creating application, selecting appropriate
applicant’s classification would be essential for this param-
eter to be effective.

UIX_VIEW_SE-
CURED_APPLICATION

This is used to specify whether an application can be
viewed by a specific responsibility (users). Parameter
value is Boolean (Yes/No) and when flagged as Yes, such
applications would be viewable only by users defined in
the Organization, Division hierarchy with the specified
responsibilities. For example, all employee accounts may
not be viewable by all users and should be made available
only to the HR department with specific responsibility lev-
els.

Note: While creating application, selecting appropriate
applicant’s classification would be essential for this param-
eter to be effective.

ULG_DAY_END

This is used to specify the upper limit time in day for a user
to be able to work in the System. Parameter value is
numeric and range is 1-24, else system will throw error.

ULG_DAY_START

This is used to specify the lower limit time in day for a user
to be able to work in the System. Parameter value is
numeric and range is 0-24, else system will throw error

ULG_FAILED_LOGIN_TRI-
ALS_MAX

This parameter is used to specify the maximum number of
login trials allowed before disabling the User ID due to
security reasons. Input parameter value is numeric with
upper limit of 999999999999.
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Parameter

Description

ULG_INACTIVITY_DAYS_ -
MAX

This parameter is used to specify the maximum number of
days the User ID can be without utilization before disabling
the User ID due to security reasons. Within the specified
number of days the User Id must be utilized for sign in at
least once. Input parameter value is numeric with upper
limit of 999999999999.

ULG_PWD_CASE_SENSI-
TIVE_REQ

This is used to allow all passwords to be case sensitive or
otherwise. Input parameter value is Boolean (Yes/No).
When this parameter is set as ‘NO’, password would be
stored in Upper case. If this parameter is set to N. then the
ULG_PWD_LOWER_CHAR_REQ parameter should also
be set to N.

ULG_PWD_CHANGE_-
DAYS_ACTUAL

This is used to set the maximum number of days after
which system will force a password change, in cases
where the User has not changed the password. Input
parameter value is numeric with upper limit of
999999999999.

ULG_PWD_CHANGE_-
DAYS_PROMPT

This is used to set the maximum number of days after
which system will prompt the User for password change, in
cases where password has not been changed within the
set period. Input parameter value is numeric.

ULG_PWD_LENGTH_MIN

This is used to set the minimum length of password string
that is required. If this criterion is not met, system would
throw an alert specifying minimum character length
required to be input.

ULG_PWD_LOW-
ER_CHAR_REQ

This is used to allow at least one lower case character in
password strings. Input value is Boolean (Yes/No). Setting
this as ‘NO’ would mean passwords would be allowed in
uppercase only.

ULG_PWD_NBR_REQ

This parameter allows setting password with at least one
numeric character. Input value is Boolean (Yes/No) and
setting this as ‘YES’ would require passwords to have at
least one numeric character.

ULG_PWD_SPE-
CIAL_CHAR_REQ

This parameter is used to allow special characters like ‘$’,
‘#,‘@’, in passwords. Input value is Boolean (Yes/No) and
setting this as ‘YES’ would require passwords to have at
least one special character.

ULG_PWD_UP-
PER_CHAR_REQ

This is used to allow at least one upper case character in
password strings. Input value is Boolean (Yes/No). Setting
this as ‘NO’ would mean passwords would be allowed in
lowercase only.

ULG_WEEK_END

This parameter enables to set the last day of the week
when a user can have access to the system. Input param-
eter value is numeric ranging from 1 to 7. This is useful in
business requirements where the Organization does not
need a specific set of responsibilities (users) to not access
the system on a weekend / week-off day etc.
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Parameter

Description

ULG_WEEK_START

This parameter is used to set the start day of the week
when a user is allowed to access the system. Input param-
eter value is numeric.

CRB_ERROR_VALIDA-
TION_IND

This parameter is used to validate the Credit Bureau report
generation request depending on the number of days per-
mitted to pull a Bureau report from the same company and
for the same customer and report as either warning/error.

When the number of days is less than or equal to the per-
mitted days (as defined in parameter
DAYS_TO_PULL_CRB_REPORT), system displays an
‘Error’ message stating ‘Bureau Report exists for the same
Customer from the same Bureau for Account# XYZ’ along
with list of account number(s) and/or application num-
ber(s). If not, a ‘Warning’ message is display and request
is accepted for processing.

Note: Both ‘CRB_ERROR_VALIDATION_IND’ and
‘DAYS_TO_PULL_CRB_REPORT are to be enabled for
Credit Bureau report processing.

OCP_CUST_PMT_PREF

This parameter MASTER ACCOUNT ROLLUP FOR PMT
EXTRACT FILE is used to decide the basis of dues con-
solidation at master account level based on the parameter
values selected. For more information, refer to ‘Outbound
Customer Extracts To Payment Agencies Batch’ section.

Company Parameters

Company parameters control the processes associated with functions that vary for different
companies and branches. These parameters address credit scoring, credit bureau interfaces,
fax services, and fax generation.

Individual parameters may be set up with different values for uniquely defined company and
branch combinations (i.e. these can be defined to the level of branches in each company or
a group of companies in terms of applicability).

Parameter

Description

AUD_ADV_REASON_-
MODEL

This parameter is used to set-up default adverse action
reasons for scoring models during set-up in the Parame-
ters sub page. Whenever the flag ‘Bureau Score Reasons’
is unchecked during credit bureau scoring model set-up,
then automatically rejected applications scored using this
scoring model picks up the Adverse Action Reasons from
the Parameters sub page.
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Parameter

Description

AUD_SCORING_METHOD

This parameter is used to set when/where the application
scoring method has to be applied within the company. So
when the parameter value is chosen as ‘primary applicant
only’, the system will perform the application scoring for
the primary applicant only and according to other applica-
ble parameters specified. Other parameter input values
are Minimum Score, Maximum Score, Minimum Tier
(Grade), Maximum Tier (Grade).

AUD_SCORING._-
METHOD_IN_BUREAU

This parameter is used to define what value to be picked
up for application scoring from the scores returned from
the various bureaus. The input parameter values are Max-
imum Score and Minimum Score. If Maximum score is set-
up in company parameters, then for all applications where
a bureau report is pulled, the system will pick-up the Maxi-
mum score from the different bureaus.

CBU_DATA_SET_SIZE

Parameter to define the metro 2 file data selection criteria,
option values are monthly, Daily, weekly, semi monthly.

CBU_FILE_FORMAT

Metro 2 file format definition, user need to select from the
parameter value drop down.

CMN_ASE_VALIDATE_-

This parameter is set up to specify to the system whether it

MAKE_MODEL needs to validate the asset make and model at the time of
data entry. In parameter value is Boolean (Yes/No).
CMN_CMB_DE- This is used to define the default printer for printing. The

FAULT_PRINTER

input parameter value is the printer name. There is no
LOV for this field. If no default printer is defined and the
parameter enabled, the system would display ‘Undefined’.

CMN_WEEKLY_NONBUSI-
NESS_DAYS

This parameter is used to set-up the weekly holidays at
the company level. The input parameter value is character
string; if no details specified and parameter is enabled,
system would display ‘UNDEFINED’.

COR_STORAGE_DIREC-
TORY

This parameter is used to specify the path/location for Ora-
cle directory object template for correspondence docu-
ments. Input parameter value is ‘SETME’; if none is
specified and parameter enabled, ‘UNDEFINED’.

DBR_-
JOINT_INC_DEBT_WITH_
2NDRY

This parameter defines whether system should consider
income and debt details of the Spouse and Secondary
Applicant along with that Primary Applicant. Input parame-
ter value is Boolean (Yes/No).

DBR_-
JOINT_INC_DEBT_WITH_
SPOUSE

This parameter is used to define whether system should
consider the income and debt details of Spouse alone
along with that of Primary applicant details. Input parame-
ter value is Boolean (Yes/No).
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Parameter

Description

DDP_CRB_EXPIRATION_-
DAYS

This parameter is used to define the credit bureau report

expiration days. So if this is set as 30, system will use all

available credit bureau reports pulled which are not older
than 30 days from current day, during de-dupe. Input value
is numeric with no upper limit.

DDP_DE-
DUP_DEBT_WITH_2NDRY

This parameter defines whether the system should de-
dupe credit bureau liabilities for Spouse and Secondary
Applicants, in addition to de-duping Primary applicant’s lia-
bilities. Input parameter value is Boolean (Yes/No).

DDP_DE-
DUP_DEBT_WITH_SPOU
SE

This parameter defines whether the system should de-
dupe credit bureau liabilities for Spouse, in addition to de-
duping Primary applicant’s liabilities. Input parameter
value is Boolean (Yes/No).

DOT_STORAGE_DIREC-
TORY

This parameter is used to define the location/path of the
Oracle Directory Object name for Account Document
Loading. Input parameter value is ‘SETME’.

ECB_EDIT -
FAIL_ANY_APL

This parameter is used to set the credit bureau edit to fail
in case the bureau report for any of the applicant fails.
Input parameter value is Boolean (Yes/No). So if this
parameter is set to ‘YES’, the edit will fail even if one of the
applicant’s bureau score fails to qualify.

ECB_USE_APL_CUR-
RENT_SCORE_CRH

This parameter is used to define whether the system
should run the credit bureau edits only on the current
scored applicant bureau. Input parameter value is Boolean
(Yes/No).

LOR_AUTOMATIC_CON_-
FUND_FAX

This is used to define the decision fax generation when an
application is funded. The input parameter value is
Boolean (Yes/No), and when this is set as ‘YES’, system
automatically generates the fax approval in the pre-
defined template whenever an application is approved.

LOG_STORAGE_DIREC-
TORY

This parameter is used to define the Oracle storage direc-
tory. Input parameter value is user (System Administrator)
defined.

LOR_AUTOMATIC_AP-
PROVAL_FAX

This is used to define the decision fax generation when an
application is approved. The input parameter value is
Boolean (Yes/No), and when this is set as ‘YES’, system
automatically generates the fax approval in the pre-
defined template whenever an application is approved.

LOR_AUTOMATIC_RE-
JECTION_FAX

This is used to define the decision fax generation when an
application is rejected. The input parameter value is
Boolean (Yes/No), and when this is set as ‘YES’, system
automatically generates the rejection fax in the pre-defined
template whenever an application is declined.
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Parameter

Description

MAX_LEAD_DAY_AGE

This parameter is used to define the maximum no. of days,
post which the sales lead would be considered cold. Input
parameter value is numeric with no upper limit.

MULTI_OFFER

Through this parameter the multiple offers (sub-tab) in
pricing can be enabled or disabled for a Company/Branch.
Input parameter value is Boolean (Yes/No). If the flag is
set as 'Y’, the underwriter can view multiple offers and
select one of them to be applied for the specific applica-
tion.

MULTI_OFFER_MAX-
_NUMBER

This parameter is used to specify the maximum number of
multiple offers that can be permitted for an application.
Input parameter value is numeric with no upper limit. If
MULTI_OFFER company parameter is set as ‘N’, this
parameter can be ignored as there is no use specifying a
value.

MULTI_OFFER_MAX-
_TERM

This company parameter sets the maximum term (as in
no. of instalments, whichever billing cycle is selected) for
which multiple offers are calculated and displayed during
pricing. Input parameter value is numeric.

MULTI_OF-
FER_MIN_TERM

This company parameter sets the minimum term (as in no.
of instalments, whichever billing cycle is selected) for
which multiple offers are calculated and displayed during
pricing. Input parameter value is numeric.

MULTI_OFFER_PMT_TOL-
ERANCE

For Multi offer variance in payment is defined in this
parameter.

MULTI_OFFER_TERM_-
VAR

For multi offer Term variance will be defined in the parame-
ter.

PRESENT_VALUE_COM-
PUTE_RATE

This parameter will perform Present Value Computation
Rate (Inflation/Discounting Rate).

RATE_CHG_L-
TR_PRE_PROCESS_-
DAYS

This parameter is used to set up the number of days prior
to rate change effective date to generate rate change let-
ters in order to provide advance intimation to customers.
Input parameter value is numeric with no upper limit.

STM_GEN_AFTER_MATU-
RITY_IND

This parameter is used to enable the statement generation
for an account after the maturity date but Account remains
unpaid. Input parameter value is Boolean (Yes/No). If this
is set to ‘Y’, statements will get generated for accounts that
remain unpaid even after maturity.

UIX_RUN_AAI_ACT

This parameter is used by the system to determine
whether to create and activate an account online. Input
parameter value is Boolean (Yes/No).

UIX_UCS_CAC_MAX_-
FOLLOWUP_DAYS

This parameter is used to set up the maximum number of
days for follow up when the account is in delinquent state.
Input parameter value is numeric with no upper limit.
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Parameter

Description

UIX_UCS_CAC_MAX-
_PROMISE_DAYS

This parameter is used to set up the maximum number of
days allowed for customers who promise to pay when fol-
lowing up for delinquent accounts. Input parameter value
is numeric.

AUD_QUEUE_INI-
TIAL_CRB_FAILED

This parameter enabling will Queue the application if any
bureau failed.

UIX_UCS_CUA_MAX_-
FOLLOWUP_DAYS

This parameter will allow the user to maintain the Collec-
tions maximum follow-up days that are allowed in the sys-
tem.

XSL_TAX_INTERFACE

This parameter is used to specify the sales tax interface in
OFSLL. Input parameter value is user defined. In this case
it is held as ‘Manual’.

CMN_SYSTEM_UNDER_-
MAINTENANCE

This parameter specifies whether the system is under
maintenance or not. Input parameter value is Boolean
(Yes/No).

CMN_GL_POST DT

This parameter is used to define the GL Post Date of Com-
pany in MM/DD/YYYY format. The same is also updated
by Scheduler if ENABLED.

PTX_TX-
N_LAST PURGE_DT

This parameter stores the date when transactions were
purged last in the OFSLL system. Input parameter value is
date.

PUP_TUP_LAST_PURGE_
DT

This parameter stores the date when transactions upload
were purged last in the OFSLL system. Input parameter
value is date.

JSC_START_OF_BUSI-
NESS_TIME

This parameter is used to set the start of business time.
Input parameter value is time in 24 hour format.

CMN_PROMISE_FU-
TURE_MTHD

This parameter helps to define the future promise handling
method in the system.

When multiple ‘Promise to Pay’ records are defined on an
account and if any one of the promise is not satisfied i.e. if
there is no credit / Payment transaction of the correspond-
ing amount on the promise date, then system uses any of
the following method defined in this parameter to update
the future promises.

- No Action on future promises (default)
- Mark current and future promises as broken

- Mark current as broken but future promise as cancelled
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C.5 Other Parameters

The following additional set of parameters are also available to control system specific data
and other administration process.

Parameter Description
CRB_MAX BU- This parameter is used to determine the number of credit
REAU_PULL reports automatically per applicant. Input parameter value

is numeric.

CRB_ALL_APL_BU-
REAU_PULL

This parameter is used to set up whether credit bureau
reports should be pulled for the primary applicant only or to
all other applicants also (for joint applications), regardless
of their relationship with the primary applicant. Input
parameter value is Boolean (Y/N).

CBU_FILE_FREQUENCY

This parameter is used to set the Metro Il File Frequency
and determine whether output file is to be generated daily
or monthly. If this is monthly, then output file is written with
daily data but generated monthly.

JOINT_DE-
DUP_SPOUSE_LIABILI-
TIES

This parameter is used to determine duplicate liabilities in
the Spouse’s liabilities in de-duping logic. Input parameter
value is Boolean (Yes/No).

JOINT_DEDUP_ALLAP-
L_LIABILITIES

This parameter is used to determine duplicate liabilities of
all applicants’ liabilities in de-duping logic, irrespective of
whether they are related to each other. Input parameter
value is Boolean (Yes/No).

ASC_COL_SER_ENA-
BLED_IND

This parameter is used for enabling the Collection Servic-
ing Indicator. Input parameter value is Boolean (Y/N).

CMN_TEST_TOOL_LOG-
GING

This parameter is used to set the testing tool logging to
enable or disable testing tool log in. Input parameter value
is Boolean (Yes/No).

ICA_INPUT_FILE_FOR-
MAT

This parameter is used to specify the Input format for call
activity file. Two Parameter values are possible — US for-
mat and OFSLL format.

JSV_BI_USER

This parameter is used to define the Bl publisher User ID.
Input parameter value is user defined (Admin user).

JSV_BI_PASSWORD

This parameter is used to define the Bl publisher User
password. Input parameter value is user defined (Admin
user).

PJR_COPY_PURGED _-
DATA

This parameter is used to specify whether data should be
copied into the purge tables or not. Input parameter value
is Boolean (Yes/No).

PUP_ARCHIVE_DAYS

This parameter is used to specify the number of days after
which the transactions upload details are to be archived.
Input parameter value is numeric.
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Parameter Description

PUP_OARCHIVE_DAYS This parameter is used to specify the number of days after
which the transactions upload details are to be moved from
‘O’ tables. Input parameter value is numeric.

TPE_APPLY_LTC_- This parameter is used to specify whether late charge
FROM_CURR_DUE_DT should be applied from current due date for Pyramid Law
fee method. Input parameter value is Boolean (Yes/No).

TPE_EXCESS_PAY- This parameter will make excess payment to the memo
MENT_TO_MEMO payment by marking this Parameter as YES.

TPE_STOP_COMP_DELQ | This parameter is enabled to stop computation if the
_DAYS account is delinquent for more than 60 days.
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